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OpenSpirit Overview
OpenSpirit is a framework that provides multi-vendor application and data interoperability
that is targeted at the upstream oil and gas business. OpenSpirit removes technology
barriers that, before OpenSpirit, prevented applications from working directly with data
residing in competing application data stores or in incompatible computing platforms.

OpenSpirit also provides an event bus that enables applications from different software
vendors to cooperate in work flows as if they were produced by a common software
vendor.

TIBCO OpenSpirit Runtime

TIBCO OpenSpirit® Runtime is composed of software infrastructure and services needed to
connect applications to data and other applications. OpenSpirit® Runtime is typically
installed on all computers in your enterprise that are used to run applications that connect
to OpenSpirit Runtime and on computers hosting data stores that feed the applications
with data. For more information about the typical network configurations of OpenSpirit
Runtime, see the TIBCO OpenSpirit® Runtime User Guide.

Application Adapter

An application adapter is the software component that connects a software application to
OpenSpirit Runtime. Applications that consist of an OpenSpirit application adapter are
called OpenSpirit enabled applications.
Application adapters are typically created by the same company that creates the software
application. However, some applications provide mechanisms to enable customers and
other companies to plug additional capabilities into their application.

Note: The TIBCO OpenSpirit© Adapter for Petrel and the TIBCO OpenSpirit©
ArcGIS extension are examples of application adapters that were not developed
by the same company that created the application.

Application adapters can connect to OpenSpirit Runtime in a variety of ways. They can
connect to read data and/or write data that resides in a data store that has OpenSpirit
data connector support. Application adapters can also interact with other OpenSpirit
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enabled applications using various application interaction events such as data selection,
cursor tracking, and GIS spatial feature events.

Application adapters typically check out a Universal Application Adapter (UAA) license
when they connect to OpenSpirit Runtime. UAA licenses are checked out per-concurrent
user for a given application type. Application adapters may also require a license from the
software company that developed and sells the application adapter. Check with your
application adapter supplier regarding the license requirements of a particular adapter. For
more information, see the TIBCO OpenSpirit® Runtime User Guide.

Data Connector

A software component that publishes a data store to OpenSpirit Runtime is called a data
connector. Publishing a data store to OpenSpirit Runtime makes its data available to
OpenSpirit enabled applications. Applications can query, create, modify, and delete data
residing in the data store.

Currently, all OpenSpirit data connectors are developed by TIBCO. OpenSpirit data
connectors are licensed by data store type on a per-concurrent user basis. For information
about the data stores supported by OpenSpirit data connectors, see the Data Source
Configuration Tool section on the Help tab of the OpenSpirit desktop menu bar.

OpenSpirit Tools

OpenSpirit tools are software components included in OpenSpirit Runtime. There are also
some optional OpenSpirit tools that are purchased separately and installed into OpenSpirit
Runtime. The OpenSpirit tools are accessed from the OpenSpirit desktop and are organized
into three categories. Administrator tools, data manager tools, and tools used in a variety
of work flows that have been grouped into a category called data browsing tools.

For a list of all the available OpenSpirit tools, see the Help guide of the OpenSpirit desktop
application.

The next section of this guide introduces additional OpenSpirit concepts that are
fundamental to how OpenSpirit software is installed and configured.
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OpenSpirit Desktop Concepts
This section of OpenSpirit Desktop Concepts covers the following topic:

OpenSpirit Desktop
The OpenSpirit Desktop provides a variety of tools used to perform data browsing, data
management, and administration of the OpenSpirit Runtime environment.

The tools are grouped into one of three task-oriented tool bars.

Data Browser Tool Bar
The Data Browser tool bar contains tools used to browse data. This

includes tools used to browse and select data, graphically display data, create and manage
sessions, monitor and manage OpenSpirit data server processes, and manage data access
credentials.
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Administrator Tool Bar
The Administrator tool bar contains tools used to administer the OpenSpirit

Runtime environment. This includes tools used to manage OpenSpirit users, create and
modify data source configurations, license management, and OpenSpirit Runtime
environment configuration. Access to administrator tools may be restricted to designated
OpenSpirit administrators according to user rights policies.

Data Manager Tool Bar
The Data Manager tool bar contains tools used to perform data

management functions. This includes tools used to customize Data Selector model views,
tools used to build and run data copy jobs, and tools used to build and run spatial data
scan jobs. Access to data manager tools may be restricted to designated data manager
users according to user rights policies set by the OpenSpirit Runtime administrator.

Tip: The Copy Manager tools and Scan Utility tool are optional components that
are installed and licensed separately. They are not present in the tool bar if the
optional product has not been installed into your OpenSpirit Runtime.

Each of the OpenSpirit tools is described in their own section of this help guide.

Launching the OpenSpirit Desktop
The following information describes the standard ways to start the OpenSpirit Desktop.
Your company may provide custom menus or scripts for you to use to start the OpenSpirit
desktop. Please consult with your local OpenSpirit system administrator about using any
customized start procedures.

Many tools provided by the OpenSpirit Desktop make use of information that is stored in
the OpenSpirit metadata repository. The OpenSpirit metadata repository is a database that
is bundled with each OpenSpirit master installation. The metadata repository contains
information such as OpenSpirit user preference settings, data source locations and
connection information, OpenSpirit license path, etc. A primary function of the OpenSpirit
shared services daemon is to provide OpenSpirit enabled applications and data connectors
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with access to the metadata repository. The OpenSpirit shared services must be running
for applications and data connectors to be able to access the metadata repository.

OpenSpirit Desktop not runs if it is unable to communicate with the OpenSpirit shared
services daemon. This can happen if the shared services daemon is not running, or if there
is a network outage that prevents communicating with the computer used to run the
shared services daemon. The following error dialog is displayed if the desktop cannot
connect to the shared services daemon.

Contact your local OpenSpirit administrator to resolve issues with the OpenSpirit shared
services daemon if this window appears when starting the OpenSpirit Desktop.

Starting on Microsoft Windows Platforms
An entry is created in the Windows start menu or on the Windows desktop when
OpenSpirit is installed on a computer running a Microsoft Windows operating system. The
entry is titled OpenSpirit v#.# Desktop where v#.# is the version of OpenSpirit installed
on your system.
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Click the start menu entry to run the OpenSpirit Desktop. The desktop can also be started
using the ospdesktop.bat file provided in the bin folder of your Microsoft Windows
OpenSpirit software installation.

Starting on Linux Platforms
The OpenSpirit desktop is started on Linux using the ospdesktop script that resides in the
bin directory of your OpenSpirit software installation. You must have the DISPLAY
environment variable set properly in order to successfully run the script. It is also required
to have an OSP_CONFIG environment variable set that points to the directory containing
your OpenSpirit configuration settings. The environment variable is not required if your
configuration settings directory resides in the default location under your OpenSpirit
software installation directory. Consult with your local OpenSpirit administrator about the
proper OSP_CONFIG environment variable setting to use.



TIBCO OpenSpirit® Runtime User Guide

13 | OpenSpirit Desktop Concepts

Desktop Overview
Along the top of the Main Window, you find the menus and the tool bars.

File Menu
The File menu contains options used to open and save files and an option to exit the
OpenSpirit Desktop. See the file extension table below for a list of desktop tools that have
information that can be opened or saved using the File menu options.

Save Menu Option

The Save menu option is enabled when the currently selected tool that is open in the
desktop has information that can be saved and the information has changed since the last
save. For example, the OpenSpirit Data Selector tool enables the Save option if any
changes are made to the information in the Data Selector, such as changing any display
options, changing a row selection, etc. Clicking an enabled Save option saves the currently
selected tool's information to the default file name and location. The default file name is
determined by the currently active tool.

The default location that files are saved in differs according to the host operating system
the desktop is running on. The default saves directory for the operating systems supported
by OpenSpirit is indicated in the following table.
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Operating System Default Save Directory*

Linux $HOME/OpenSpirit/v#.#/Desktop

Microsoft Windows %LOCALAPPDATA%\OpenSpirit\v#.#\Desktop

* Substitute the major and minor version number of the OpenSpirit Runtime that you are
using for the "#.#" component of the directory path.

Save As Menu Option

The Save As menu option is enabled when the currently selected tool that is open in the
desktop has information that can be saved. Clicking the Save As option displays a file
selector window that can be used to select the directory that the file should be written to
and the name to give the file.

Open Menu Option

The Open menu option is always enabled. Clicking the Open option displays a file selector
window that can be used to select a file created by a previous Save or Save As operation.

The following table lists the file name extensions of save files created by OpenSpirit
desktop tools. The table indicates the desktop tool used to view the save file and describes
how the file is created and its purpose.

Desktop Tool File Name Extensions

File Name
Extension

Desktop Tool
used to View

Description

.ospdataselector Data
Selector

This file is produced when clicking the Save or Save
As icon in the Data Selector tool bar or in the
desktop's File menu if the active tool is a Data
Selector. The file contains the current state of the
Data Selector, including the rows that are currently
selected.
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File Name
Extension

Desktop Tool
used to View

Description

.ospselections Data
Selector

This file is produced by a copy or scan job and
contains the rejection list produced by that job. The
file is stored in the OpenSpirit master installation's
metadata repository when the copy or scan job
completes. The file can be exported from the
metadata repository by clicking the Send to
support icon in the Job Run History tool. This
produces a zip file that contains the rejection file
along with other files related to the job run. A Data
Selector is opened to display the rejection list when
this file is opened using the desktop's Open menu
option.

.ospmodelview Model View
Manager

This file is produced when clicking the Export icon
in the Model View Manager tool. Selecting this file
using the desktop's Open menu option initiates an
import of the model view into the OpenSpirit master
installation's metadata repository and will open the
Model View Manager if it is not already open. An
overwrite prompt appears if the model view exists.

.ospcopyrep Copy Job
Execution
Report

This job execution report file is produced by a copy
job. The file is stored in the OpenSpirit master
installation's metadata repository when the copy job
completes. The file can be exported from the
metadata repository by clicking the Send to
support icon in the Job Run History tool. This
produces a zip file that contains the report file along
with other files related to the job run. A Copy Job

Execution Report tool is opened to display the
report when this file is opened using the desktop's
Open menu option. The execution report and the
job messages can be viewed using the Copy Job
Execution Report tool.
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File Name
Extension

Desktop Tool
used to View

Description

.ospcopydiag Copy
Job
Diagnostic
Log

This file is produced if a copy job is ran with the log
level set to DEBUG. The file contains all of the
information found in the execution report along
with the debug messages produced by the job. This
file is not stored in the OpenSpirit master
installation's metadata repository. The file is
however included in the zip file produced when
clicking the Send to support icon on the Job Run
History if the zip file is created from the same
account and host computer used to run the copy
job.

.ospcopyjob Copy
JobManager

This file is produced by clicking the Export icon in
the Copy Job Manager tool bar. Selecting this file
using the desktop's Open menu option will initiate
an import of the copy job into the OpenSpirit
master installation's metadata repository. The job
will only be imported if it does not exist in the
metadata repository. The copy job appears in the
Copy Job Manager's job list.

Note, the Copy Job Manager is not automatically
opened when opening the copy job file. Click the
Copy Job Manager tool bar icon if the Copy Job
Manager is not already open. The imported job can
then be viewed by selecting it from the list of copy
jobs and clicking the View copy job icon.

.ospscanrep Scan
Job
Execution
Report

This job execution report file is produced by a scan
job. The file is stored in the OpenSpirit master
installation's metadata repository when the scan job
completes. The file can be exported from the
metadata repository by clicking the Send to
support icon in the Job Run History tool. This
produces a zip file that contains the report file along
with other files related to the job run. A Scan Job
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File Name
Extension

Desktop Tool
used to View

Description

Execution Report tool is opened to display the
report when this file is opened using the desktop's
Open menu option. The execution report and the
job messages can be viewed using the Scan Job
Execution Report tool.

.ospscandiag Scan
Job
Diagnostic
Log

This file is produced if a scan job is ran with the log
level set to DEBUG. The file contains all of the
information found in the execution report along
with the debug messages produced by the job. This
file is not stored in the OpenSpirit master
installation's metadata repository. The file is
however included in the zip file produced when
clicking the Send to support icon on the Job Run
History if the zip file is created from the same
account and host computer used to run the scan
job.

.ospscanjob Scan
JobManager

This file is produced by clicking the Export icon in
the Scan Job Manager tool bar. Selecting this file
using the desktop's Open menu option will initiate
an import of the scan job into the OpenSpirit master
installation's metadata repository. The job will only
be imported if it doesn't already exist in the
metadata repository. The scan job will appear in the
Scan Job Manager's job list.

Note: The Scan Job Manager is not automatically
opened when opening the scan job file. Click on
the Scan Job Manager tool bar icon if the Scan
Job Manager is not already open. The imported
job can then be viewed by selecting it from the
list of scan jobs and clicking on the View scan
job icon.
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View Menu
The View menu contains options used to turn the desktop tool bars on or off and turn the
Progress Bar on or off. It also contains an option to open the desktop preference settings
window.

Toolbars Menu Option

The Toolbars menu option opens a submenu that contains menu options to turn each of
the desktop's tool bars on or off.

Data Browser Menu Option

The Data Browser menu option is found in the Toolbars submenu. This menu option is
used to display the tool bar that contains icons used to open tools commonly used in data
browsing work flows. A check mark icon is shown next to the menu option if the tool

bar is visible. The check mark is not shown if the tool bar is not currently visible. Selecting
the menu option toggles the tool bar on or off.

Administrator Menu Option

The Administrator menu option is found in the Toolbars submenu. This menu option is
used to display the tool bar that contains icons used to open tools commonly used in
OpenSpirit system administration work flows. A check mark icon is shown next to the
menu option if the tool bar is visible. The check mark is not shown if the tool bar is not
currently visible. Selecting the menu option toggles the tool bar on or off.

Data Manager Menu Option

The Data Manager menu option is found in the Toolbars submenu. This menu option is
used to display the tool bar that contains icons used to open tools commonly used in data
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management work flows. A check mark icon is shown next to the menu option if the
tool bar is visible. The check mark is not shown if the tool bar is not currently visible.
Selecting the menu option toggles the tool bar on or off.

Progress View Menu Option

The Progress View menu option is used to display the Progress View tool. A check mark
icon is shown next to the menu option if the Progress View tool is visible. The check
mark is not shown if the Progress View tool is not currently visible. Selecting the menu
option toggles the Progress View tool on or off.

Preferences Menu Option

The Preferences menu option opens the OpenSpirit Desktop Preference window.

Tools Menu
The Tools menu provides access to the options that are also provided in the desktop's tool
bars. It is provided as a convenience to enable you to quickly access an option that resides
in a tool bar that is not currently turned on for display. Selecting one of the tool categories
opens a submenu containing menu options for all the icons found in the corresponding
tool bar.

DataBrowser Menu Option

The DataBrowser menu option opens a submenu containing options to open the data
browsing tools. The data browser tools are described in the Data Browser Tool Bar section
below.



TIBCO OpenSpirit® Runtime User Guide

20 | OpenSpirit Desktop Concepts

Administrator Menu Option

The Administrator menu option opens a submenu containing options to open the
administrator tools. The administrator tools are described in the Administrator Tool Bar
section below.

DataManager Menu Option

The DataManager menu option opens a submenu containing options to open the data
manager tools. The data manager tools are described in the Data Manager Tool Bar section
below.
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Tip: The Copy Job Manager and Copy Rule Manager menu items appear if the
TIBCO OpenSpirit Copy Manager product is installed. The Scan Job Manager
menu item appears if the TIBCO OpenSpirit Scan Utility product is installed.

Help Menu
Help menu contains options to display this help document, information about your
OpenSpirit installation, and the log file containing messages generated by the OpenSpirit
Desktop.

Help Contents Menu Option

Help Contents menu option opens this help document.
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OpenSpirit Runtime v4.3.1 Menu Option

OpenSpirit Runtime v4.3.1 menu option opens a web page that displays information about
your OpenSpirit installation and provides links to OpenSpirit data model and API
documentation. This is the same web page that is displayed when selecting the OpenSpirit
Runtime v4.3 Page option from the Windows Start menu entry for OpenSpirit.

About OpenSpirit Desktop Menu Option

About OpenSpirit Desktop menu option opens a window containing information about your
OpenSpirit installation environment.

View Log Menu Option

View Log menu option opens a window that displays the log file created by the OpenSpirit
Desktop. The log file may contain helpful information if you run into problems using one of
the desktop tools.

Data Browser Tool Bar
DataBrowser tool bar contains icons used to open tools that are primarily used in data
browsing work flows.

Tip: The OpenSpirit Section Viewer, Well Viewer, 3D Viewer, and Excel Adapter
are launched from the OpenSpirit desktop, but they run as independent
applications.

Data Selector

Data Selector tool is a data selection and query utility that presents a tabular summary of
selected attributes associated with the data types that are supported by the OpenSpirit
Framework. The Data Selector can be used to browse data from any data source supported
by the OpenSpirit framework. The Data Selector is also used to send data selection events
to applications that support listening for OpenSpirit data selection events.
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Process Manager

Process Manager tool is used to monitor and control processes that have been started by
the OpenSpirit framework to service data requests. The tool shows all processes owned by
the user and provides access to the process log file and settings. The tool can also be used
to shut the processes down.

Session Manager

Session Manager tool is used to create, view, modify, and delete OpenSpirit sessions
owned by the user.

Section Viewer

Section Viewer is used to graphically display 2D seismic lines and 3D seismic sections. The
viewer can also display 2D and 3D horizon and fault cross sections.

Well Viewer

Well Viewer is used to graphically display well logs and well markers. The viewer supports
dynamic addition and removal of well tracks.

Excel Adapter

Excel Adapter is used to import data into Microsoft Excel spreadsheets. It is a separately
licensed tool.

User Setup Wizard

User Setup Wizard is used to enter host and account preferences for running OpenSpirit
data connectors and data source credentials and preference settings.

3D Viewer

3D Viewer is used to graphically display well, seismic, interpretation, and culture data in a
three-dimensional view.
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Tip: A coordinate selection window appears when launching the 3D Viewer. The
window is used to select the coordinate system and the units that are used to
define the 3D Viewer's coordinate space. Select an appropriate projected
coordinate reference system for the data that you intend to view.

A second window will appear after clicking the coordinate system selection window's Ok
button to ask if the 3D Viewer should display data using seismic time or depth for its
vertical display axis.
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The 3D Viewer will appear ready to accept data selection events after clicking the
Time/Depth window's Ok button.

Administrator Tool Bar
The Administrator tool bar contains icons used to open tools that are primarily used in
work flows for administering the OpenSpirit environment.

Data Source Configuration

In order for OpenSpirit to access data in the various vendor data sources, you must tell
OpenSpirit about each source, which is known as configuring the data sources. Information
entered in this tool provides the OpenSpirit framework with the necessary information to
locate and access data in vendor data stores, such as OpenWorks, Studio, PPDM, etc.

License Monitor

The License Monitor tool is used to view the features that are available in your OpenSpirit
license and to monitor their usage. The License Monitor can also be used to force check in
licenses when running the OpenSpirit Desktop in admin mode.

User Manager

The User Manager tool is used to view and modify information about registered OpenSpirit
users. It is also used to manage OpenSpirit access rights.

Toggle Admin Mode

The Toggle Admin Mode tool bar button is used to toggle admin mode on and off in the
OpenSpirit Desktop. See the Changing to Admin Mode section of this guide for information
about admin mode.

Data Manager Tool Bar
The DataManager tool bar contains icons used to open tools that are primarily used in data
management work flows.
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Copy Job Manager

The Copy Job Manager tool is used to create and schedule jobs to copy data from one or
more OpenSpirit data sources to a target data store. This is a separately licensed tool and
appear in the tool bar if it has been installed. The OpenSpirit administrator may restrict
access to this tool to specifically authorized users.

Copy Rule Manager

The Copy Rule Manager tool is used to create and modify the data source type specific
rules used by the Copy Job Manager when copying data. This is a separately licensed tool
and appear in the tool bar if it has been installed. The OpenSpirit administrator may
restrict access to this tool to specifically authorized users.

Scheduled Jobs tool

The Scheduled Jobs tool is used to view and manage Copy and Scan jobs that have been
scheduled to run at a future time.

Job Run History tool

The Job Run History tool is used to view Copy and Scan jobs that are currently running or
have run in the past.

Model View Manager tool

The Model View Manager tool is used to create and modify Model Views used by the Data
Selector and Scan Job Manager tools.

Scan Job Manager tool

The Scan Job Manager tool is used to create and schedule jobs to scan spatial data
residing in OpenSpirit data sources and write the spatial data to ESRI SDE, shape files, or
ESRI File GeoDatabase. This is a separately licensed tool and appear in the tool bar if it has
been installed.
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Desktop Tool Bar
The Desktop tool bar is always displayed.

Desktop Preferences

The Desktop Preferences settings window is opened using this tool bar icon.

Changing to Admin Mode
Admin Mode enables public OpenSpirit resources to be created, edited, and deleted.
Examples of public resources are public data source configurations, OpenSpirit users,
public sessions, and public model views. Admin Mode should only be used by individuals
that have been assigned responsibility to configure and administer your OpenSpirit
environment.

OpenSpirit Desktop opens in normal mode when it is started by a user other than the
OpenSpirit administrator. Admin Mode can be enabled when running the OpenSpirit
Desktop using a non-admin account by pressing the Toggle Admin Mode tool bar icon
or by selecting the Tools >Administrator > Toggle Admin Mode menu option. This opens
a prompt for the administrator password unless your account has been granted the
Administer OpenSpirit Runtime right by your OpenSpirit administrator. The button
appears with a green check mark when the desktop enters admin mode.

Note: Be careful when running in admin mode. You are able to delete
information that may be difficult or impossible to recover.

OpenSpirit Desktop opens automatically in Admin Mode when it is run using the
OpenSpirit Administrator account. The Toggle Admin Mode tool bar icon appears disabled

when using the OpenSpirit administrator account because the desktop is always in
admin mode when running from the OpenSpirit administrator account.

Desktop Log
The Desktop Log window is accessed from the OpenSpirit Desktop by choosing the Help >
View Log menu item. The Desktop Log window displays informational messages generated
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by the OpenSpirit Desktop tools. The Desktop Log Level setting on the OpenSpirit Desktop
preferences page controls the amount of detail that appears in the Desktop Log window.

The log messages are written to a file named Desktop.log in your OpenSpirit logs folder.

The location and name of the Desktop's log file is shown at the top of the log window.

Click the Refresh button at the bottom left of the Desktop Log window to show any new
entries that may have been written to the log file since the log window was opened.

Check the Wrap lines option to wrap long lines and eliminate the horizontal scroll bar.

Click the Save As button to save the current content of the log file to another file of your
choosing. New entries continue to be written to the original log file. The save as option
creates a copy of the log file, it does not rename or replace it.

Progress View
Progress View is displayed by selecting the View -> Progress Bar menu option or by
checking the Show progress view option in the OpenSpirit Desktop Preferences page. The
Progress View is a window that displays the progress of desktop operations that take
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significant time to complete. A progress bar appears in the Progress View window for each
long running operation. A rectangular red icon is displayed to the right of each
progress bar. Clicking the red icon cancels the long running operation. Note, you may have
to re- size the Progress View window vertically in order to see all the progress bars.

Desktop Preference Settings
This section of Desktop Preference Settings covers the following topic:

Desktop Preferences
The Desktop Preferences dialog is accessed from the OpenSpirit Desktop by choosing the
View > Preferences menu item or by clicking the preferences icon in the Desktop's tool

bar. The list of available preference pages is displayed along the left side of the preferences
dialog. The contents of this list vary depending on which OpenSpirit Desktop tools have
been installed into your desktop. The right side of the preferences dialog shows the
content of the selected preference page. Changes made to a preference page can be
immediately saved by pressing the Apply button. The Restore Defaults button reverts the
preference settings on the displayed page to the factory default values. Pressing the Ok
button, applies any changes made to any of the preference pages and dismiss the dialog.
Pressing the Cancel button discards any unapplied changes to any preference pages and
dismiss the dialog. Pressing the Help button displays this help document.
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Selecting the OpenSpirit Desktop item on the left panel displays the page for setting the
desktop logging level, the option to show the progress bar as a view window, and the
desktop exiting behavior setting.

The Desktop Log Level setting controls the amount of information that available for
viewing in the Desktop Error Log window. Avoid setting this to All or Debug unless
instructed to do so by OpenSpirit support in order to avoid overwhelming the desktop with
a massive amount of log message.

The meaning of each log level is described in the following table.

Log
Level

Description

ERROR Produces the least amount of log file output. This level should only be used if
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Log
Level

Description

you have no interest in anything but failures.

WARN Produces less output than INFO. Consider using this level if you are trying to
keep the log file size down and are not interested in details of successful
operations. Only failure information is reported.

INFO The default level. This is the recommended log level. It produces a
reasonably detailed amount of information.

DEBUG Produces a large amount of output. You typically should not use this level
unless instructed by OpenSpirit support. Large numbers of program
execution messages needed to diagnose problems are produced when this
log level is used.

ALL Produces a tremendous amount of output. This level should never be used
unless instructed by OpenSpirit support. Volumes of very detailed program
execution messages needed to diagnose difficult problems are produced
when using this log level. This log level may produce multi-gigabyte log files.

The Show progress view option controls display of the Progress View window.

The When exiting desktop option controls the data server process shutdown behavior
when exiting the desktop. The default value for this option is to prompt when exiting the
desktop.
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The prompt lists your data server processes that are currently running and asks if you
would like to shut them down. Click the Yes button to shut down the data servers, click the
No button to leave them running.

Choosing the Do nothing desktop preference option prevents the shutdown prompt when
exiting the desktop and leaves the data connectors running.

Tip: Data connectors will time out and shut down after a period of inactivity.
See the OpenSpirit Installation and Configuration Help guide for more
information about data server inactivity timeout.

Choosing the Shutdown all data servers without prompting option shutdown all of your
data server processes when exiting the desktop without prompting for confirmation.

Note: Use care when choosing the Shutdown all data servers without
prompting option. Data servers that are busy performing a copy job, a scan job,
or servicing an application such as Petrel shut down without warning and likely
cause errors in the job they are performing.

Coordinate System Preferences
Selecting the Coordinate System item on the left panel displays the page for setting the
desktop's coordinate system and unit display preferences. These settings are honored by
the data display tools that are run in the desktop, such as the Data Selector, Scan Job
Manager, and Copy Job Manager. The coordinate system and unit display settings are
optional. Data is displayed in the data store's default coordinate system and units if
desktop preferences are not set.
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Set the preferred coordinate system

A display coordinate system can be selected in three different ways. A coordinate system
can be selected from a data source, from an existing OpenSpirit session, or from the set of
predefined EPSG coordinate systems. Setting a coordinate system preference causes all
spatial data displayed in the OpenSpirit desktop tools to be transformed to the selected
coordinate system for display. Data that cannot be transformed due to coordinate system
incompatibilities does not appear (that is, it is displayed as if it were null).

Tip: The desktop coordinate system preference only affects data represented as
one of the OpenSpirit geometry types (for example, Point, LineString, Polygon).
X/Y or Lat/Long values that appear in native data models as individual values
not be transformed to the selected coordinate system.
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Set the preferred unit system

Preferences for horizontal units, depth units, and seismic travel time units cause values
that represent horizontal distance values, depth measurements, or seismic travel time to
be converted for display. Measurement fields must be tagged in the data model as having
one of these unit measurement types in order to be unit converted for display.

Tip: For example, the OpenSpirit data model's well log has an attribute called
Top Index, which may contain measured depth values or it may contain seismic
travel time values. The Top Index attribute therefore is not constrained to a
particular unit measurement and values not be unit converted to the desktop
unit preferences. The OpenSpirit data model's well pick has an attribute called
MD Value, which can only contain measured depth values. The MD Value
attribute is assigned a "length vertical" unit measurement, which results in the
values being unit converted to the desktop's depth unit preference.

Data Display Preferences
Selecting the Data Display item on the left panel displays the page for setting preferences
in how various data values are displayed in the desktop.
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Tip: Data display preferences can also be set on individual attributes in the Data
Selector or in a Model View, which overrides the desktop display preference
setting. This behavior may give the impression that the Desktop Data Display
preferences are not working. Check your Data Selector column preferences and
your Model View settings for attributes that do not appear to honor the desktop
settings.
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String Formatting Preferences

Display of character string data values can be limited to a fixed number of characters.
Leave the setting blank to display the full content of character string data values.

Note: String values are truncated to the maximum length when using
copy/paste to copy rows from the Data Selector to another application. You may
lose information during copy/paste if a maximum length preference is set.

Tip: Note, the Data Selector column widths are not increased to show the entire
string value if the maximum length is set to blank or a large number. You may
need to widen columns by stretching the column header with your mouse in
order to see the entire string.

Color Formatting Preferences

Color data values can be displayed using it as a background color.

Displaying the name of the color,

Displaying the red, green, and blue (RGB) component values of the color,
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or any combination of the three.

Floating Point and Quantity Formatting Preferences

Display of floating point numeric values can be customized in several ways. Selecting the
Use scientific notation option causes floating point numeric values to be displayed using
scientific notation (for example, 9.273E4) rather than the default decimal notation (for
example, 92730.0).

The number of fractional digits displayed to the right of the decimal can be controlled
using the Number of decimal places option. Enter an integer between zero and ten
inclusive.

Note: The Number of decimal places setting determines the precision of
numeric values when using copy/paste to copy rows from the Data Selector to
another application. You may lose precision during copy/paste if an insufficient
number of decimal places is used.

Tip: The floating point number preferences are also used to display spatial data.

Selecting the Display unit in separate column option causes measurement values to
display their unit in a separate table column rather than the default of displaying the unit
in the same column as the numeric value.
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Separate unit column display enables sorting by unit and can help when using copy/paste
to copy table rows into other applications such as Microsoft Excel. It also causes the
numeric portion of the measurement to be right aligned in the column to aid in visual
comparison of row values.

The Show blank for null array values option controls the display of null values in the
array details popup window. Select this option to display null values as a blank entry.

Deselect this option to show the numeric value used to represent null values in the array.
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Timestamp Formatting Preferences

Select the Show time when displaying a date option to display the time of day portion of
timestamp values.

Deselect this option to show only the year, month, day portion of the timestamp.

Geographic Point Formatting Preferences

Select the Display point values in separate columns option to display the x, y, and z
components of Point spatial data in separate columns.
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Deselect this option to display the x, y, and z components of Points in the same column.

Select the Display Coordinate System in separate column option to display an additional
column containing the name of the Point's coordinate system.

The coordinate system name is shown as a hyper link that pop up a coordinate system
detail display window when clicked.
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Deselect the Display the X/Lat value option to inhibit display of the X or Latitude portion
of the Point.

Deselect the Display the Y/Lng value option to inhibit display of the Y or Longitude
portion of the Point.

Deselect the Display the Z value option to inhibit display of the Z portion of the Point.
Deselecting all three is not allowed.

Geographic LineString/MultiPoint Formatting Preferences

Select the Display Coordinate System in separate column option to display an additional
column containing the name of the LineString's coordinate system.
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Data Selector Preferences
Selecting the Data Selector item on the left panel displays the page for setting preferences
that control the behavior of the Data Selector tool.

Query Preferences

Select the Auto Query option to have the Data Selector automatically run queries when
first displaying a data type tab or when making any change that requires data to be re-read
from the data source. Consider deselecting this option when using the Data Selector to
browse data sources that contain a large quantity of data. Click the query icon to
retrieve data when the auto query option is deselected.

The Limit number of rows setting provides protection when browsing data sources that
contain large numbers of data items. This setting is used as the default row limit for the
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individual data type tabs in the Data Selector. This setting establishes an upper bound on
the number of rows that returned by query and displayed in the Data Selector. This can
protect you against running queries that return far more rows than you are interested in
browsing. Enter zero for the row limit or blank out the value entirely to display all rows
without imposing a limit.

Coordinate and Unit Preferences

Selecting the Use desktop coordinate system option causes the Data Selector to attempt
conversion of all spatial data to the coordinate system selected in the Coordinate System
desktop preferences. This option has no effect if coordinate system preference has not also
been set. This option is provided to enable coordinate conversion to be easily turned off in
the Data Selector without having to remove your desktop coordinate system selection.

Selecting the Use desktop unit system option causes the Data Selector to attempt
conversion of all measurement data to the units selected in the Coordinate System
desktop preferences. This option has no effect if unit preferences have not also been set.
This option is provided to enable unit conversion to be easily turned off in the Data
Selector without having to remove your desktop unit selections.

Do Not Show Dialog Preferences

The Do not show the "No row selected" dialog again option is used to restore display of
the No row-selected warning dialog if the Do not show this dialog again option was
checked the last time the dialog appeared. Uncheck this option if you would like to have
the warnings displayed.

Web Browser Preferences
Selecting the Web Browser item on the left panel displays the page for controlling the web
browser used to display web content selected from within the OpenSpirit Desktop. You can
choose the desktop's internal browser, or you can select one of the external browsers
discovered by the desktop. You can also use the New button to add additional external
web browsers that the desktop was not able to discover on its own.
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Data Browsing Tools

User Setup Wizard Overview
The User Setup Wizard is used to select the computers and accounts that are used to run
OpenSpirit data connectors. The User Setup Wizard is also used to enter any required or
optional settings needed by OpenSpirit data connectors when establishing connections to
a data source or project, such as database accounts and passwords. It is also used to enter
your email account information if you would like to receive email messages when your
copy jobs and scan jobs complete.

The User Setup Wizard is accessed from the OpenSpirit Desktop by clicking the User Setup
Wizard tool bar icon or by choosing the Tools > DataBrowser > User Setup Wizard
menu item. The User Setup Wizard also opens automatically when starting the OpenSpirit
Data Selector if it has never run to completion.

Tip: Automatic opening of the wizard when starting the Data Selector ceases
once the wizard has been dismissed by pressing its Ok button.

The User Setup Wizard is composed of three panels. One panel is used to enter the default
host and account used to run data connectors on each operating system platform. The
second panel is used to enter data source-specific settings. The third panel is optionally
used to enter email settings. Press the Ok button to dismiss the User Setup Wizard once
the settings have been entered.

The following sections of this help guide describe the three wizard panels.
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Host Account Settings
OpenSpirit has the capability to remotely start application data connector processes
(Kingdom, OpenWorks, EPOS, Studio, and so on) to run on a different Linux or Windows
host. The Host Account Settings panel is used to provide OpenSpirit with the host, account,
and password information needed to start data connector processes to service requests for
data made by OpenSpirit enabled applications.

Tip: Data connectors can be remotely started on a Windows host by configuring
a Windows server to run an SSH daemon and configuring a Windows satellite
using the Use satellite for server activation option. See the Windows Satellite
Registration section of the Install Config Manager section of this guide for more
information about configuring Windows satellites to support remote server
activation.

The appearance of the Host Account Settings panel varies depending on the Remote
Startup Method setting selected by your OpenSpirit administrator when configuring your
OpenSpirit master installation. The possible Remote Startup Methods are described in the
following table.

Remote Startup
Method

Startup Method Description

SSH with
Password
Authentication

Processes are started using the Secure Shell network protocol using
account name and password authentication. Account passwords
entered into the User Setup Wizard are encrypted and saved by the
OpenSpirit framework. The passwords are then available whenever
the framework needs to create a process to honor a data connection
request.

SSH with
Password
Authentication
(interactive)

Processes are started using the Secure Shell network protocol using
account name and password authentication. Passwords are not
entered into the User Setup Wizard. Users are prompted for the
account password when the OpenSpirit framework needs to create a
process to honor a data connection request.
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Remote Startup
Method

Startup Method Description

Note: Any OpenSpirit Scan Utility or Copy Manager jobs that are
scheduledtorunwhentheuserisnotavailabletorespondtoa
passwordprompt fail.YoushouldmakesureanOpenSpirit Process
Starter, also known as a Locator, is already running without a
time-out on any host computers that are needed by the job.

REXEC Processes are started using the Remote Process Execution network
protocol using account name and password authentication. Account
passwords entered into the User Setup Wizard are encrypted and
saved by the OpenSpirit framework. The passwords are then
available whenever the framework needs to create a process to
honor a data connection request.

REXEC
(interactive)

Processes are started using the Remote Process Execution network
protocol using account name and password Authentication.
Passwords are not entered into the User Setup Wizard. Users are
prompted for the account password when the OpenSpirit framework
needs to create a process to honor a data connection request.

Note: Any OpenSpirit Scan Utility or Copy Manager jobs that are
scheduled to run when the user is not available to respond to a
password prompt fail. You should make sure an OpenSpirit Process
Starter, also known as a Locator, is already running without a time-
out on any host computers that are needed by the job.

External
Executable

This startup method delegates the job of starting processes to a
program or script that is external to OpenSpirit. The external
executable most commonly uses Kerberos or SSH with public key
authentication, which not requires a password.

The following sections describe the three different appearances of the Host Account
Settings panel determined by the Remote Startup Method setting of your OpenSpirit
configuration.
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Appearance when using SSH or REXEC with
Saved Password Authentication
The Host Account Settings panel of the User Setup Wizard contains a user accounts section
and a platform default host and account section when using the SSH with Password
Authentication or the REXEC remote startup method.

User Accounts

The User Accounts section of the Host Account Settings panel is used to provide the
account password to be used by the OpenSpirit framework to create data connector
processes on a different host computer from the application. Initially the account being
used to run the OpenSpirit Desktop appears in the User Accounts list. Enter the account
password and press the button if the same account name is to be used to run remote

data connector processes. It is a good practice to also press the button after saving

the password. This opens a prompt to select a host computer to use when performing the
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test. Select one of the available hosts or select the <Enter New Host> option to type in the
name of a different host. It is recommended to perform the test using the same host that
used to run data connectors.

Tip: The <Enter New Host> option to type in a new host name not appear if
your OpenSpirit installation was configured not to allow host discovery. Consult
with your OpenSpirit administrator if host discovery has been disabled and the
host you would like to use does not appear in the host selection list.

The test button changes to a green check if the test succeeds. An error message
appears and the test button change to a red stop sign, if the test fails. Re-enter the
password and press the button followed by the   button to correct the password

error. Consult your OpenSpirit administrator if you are unable to successfully pass the test.
There may be an IT infrastructure problem preventing the remote protocol from working
on the host selected to perform the test.
Additional accounts can be added to the account list if it is necessary to run a data
connector using a different account. This is done by clicking the Add Account icon . This

opens a window that can be used to enter the username and password of another account
that you would like to use to run data connector processes.

Tip: The Add Account window is not creating an account. It is merely allowing
you to tell the OpenSpirit framework about the existence of an existing account.
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The button on the Add Account window works the same as the test button on the
Host Account Settings account list.

Note: Any accounts added to the account list using the Add Account window be
forgotten by the OpenSpirit framework if not used as a default host account or if
not used for a specific data source on the Data Source Settings panel. Unused
accounts disappear from the account list when the User Setup Wizard is
dismissed.

Default Host and Account

The Default Host and Account section of the Host Account Settings panel is used to select
the host and the account to use as your default for each of the supported operating system
platforms used at your site.

Select a host and account for each of the listed platforms. OpenSpirit must be installed
and configured on a platform for it to appear in the list. It is good practice to click the
button for each default. The test button works the same as the test button on the Host
Account Settings account list except there not be a host selection prompt.

Tip: The option to type in a new host name not appear if your OpenSpirit
installation was configured not to allow host discovery. Consult with your
OpenSpirit administrator if host discovery has been disabled and the host you
would like to use does not appear in the host selection list.
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Appearance when using SSH or REXEC with
Interactive Password Authentication
The Host Account Settings panel of the User Setup Wizard contains a user accounts section
and a platform default host and account section when using the SSH with Password
Authentication (interactive) or the REXEC (interactive) remote startup method.

User Accounts

The User Accounts section of the Host Account Settings panel differs from the appearance
described in the previous section in that it does not provide the ability to add additional
accounts to the account list. Another difference is the absence of a password entry field
and associated save and test buttons. Data connector processes must be run under the
same account used to run applications.
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Tip: The account list may contain a second account if your OpenSpirit user
account was assigned a secondary account. Secondary accounts may also be
used to run data connector processes. Refer to the help documentation for the
User Manager tool for information about secondary accounts.

Default Host and Account

The Default Host and Account section of the Host Account Settings panel is identical to the
appearance described in the previous section with the exception of the absence of the test
button. Otherwise its usage and behavior is the same.

Appearance when using External Executable
The Host Account Settings panel of the User Setup Wizard does not contain a user
accounts section when using the External Executable remote startup method. The panel
only allows selection of the host to use for each platform.
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A button is provided in the bottom-right corner of the Host Account Settings panel
for proceeding to the next step in the wizard. Clicking the next button will navigate to the
Data Source Settings panel.
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Data Source Settings
The Data Source Settings panel of the User Setup Wizard is used to manage data source-
specific credentials. It can also be used to override the default host and account used for
specific data sources.

Data Source Credentials
Credentials are needed to access some OpenSpirit data sources. Some credentials are
optional and some are mandatory. Some OpenSpirit data sources do not have any
credentials. Credentials are entered by clicking the icon in the Settings column next to a
data source that has at least one credential.
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Note: The account selected in the Host/Account setting of OpenWorks, and
Studio data sources determine the projects that are shown in the Data Source
Settings panel. Select the account that is used to run the data connector before
entering any data source credentials for OpenWorks, and Studio data sources.

Data sources with no credentials not have any icon in the Settings column. The SEGY data
source shown in the image above is an example of a data source that does not have any
required or optional credentials.

A blue refresh icon next to a data source indicates that a credentials check has not

been performed. Click the refresh icon or on the project list expansion arrow to perform a
missing credentials check for the data source.

A green check mark settings icon next to a data source indicates that all mandatory

credentials needed to access the data source have been entered. Data sources with
optional credentials, or with mandatory credentials that have default values are also shown
with a green check mark icon.

A red horizontal bar settings icon is shown next to data sources having one or more

mandatory credentials that have not been entered. The missing credentials must be
entered before accessing these data sources. Click the red horizontal bar icon to display
the settings window used to enter the missing mandatory credentials.

Enter the missing credentials required by the data source and press the Ok button.

Data sources that require credentials at the project level lists all accessible projects in their
credentials window. The same credential values can be entered for multiple projects by
selecting the projects you wish to assign a credential value to and pressing the Set for
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Selected icon in the credential window tool bar. This opens a window that can be used

to enter credential values that applied to all selected projects.

Pressing the Clear credentials for selected rows icon   in the credential window tool
bar removes all credentials previously entered for all selected projects.

Tip: Credential values are not validated at the time that they are entered. Data
source credentials are validated when a connection to the data source is
attempted. This usually occurs when selecting the data source for display in the
OpenSpirit Data Selector.

Data Sources With Data Source and Project
Credentials
Some data sources have credentials at both the data source level and at the project level.
The Studio data source is an example. The credentials window for these multi-level
credential data sources contains a tab for entering the data source credentials and another
tab for entering the project credentials.
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The following table lists the credentials defined for each supported OpenSpirit data source
type.

Data
Source
Type

 Credential Credential
Scope

Required Description

EPOS Preferred WellDB
for write

Project Maybe This credential is only used
when the Use EPOS projects
option is enabled in your
EPOS 4 data source
configuration and if the
EPOS project contains more
than one well database.
Under these conditions, this
credential is required. The
credential is not required
and is ignored if either of
these conditions are not
True. The credential should
contain the name of the
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Data
Source
Type

 Credential Credential
Scope

Required Description

well database that new data
should be written to.

Preferred WellDB
for read

Project No This credential is only used
when the Use EPOS
projects option is enabled
in your EPOS 4 data source
configuration and if the
EPOS project contains more
than one well database. The
credential is ignored if
either of these conditions
are not true. The credential
should contain the name of
the well database that data
should be read from. Data
is read from all well
databases in the EPOS
project if this credential is
not present.

Kingdom Author Project Yes The Kingdom author to use
when connecting to the
Kingdom project.

Username Project Maybe The Kingdom database
username. This credential is
required if the Kingdom
project is stored in Oracle
or SQL server.

Password Project Maybe The Kingdom database
password. This credential is
required if the Kingdom
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Data
Source
Type

 Credential Credential
Scope

Required Description

project is stored in Oracle or
SQL server.

OpenWorks Interpreter Project No This credential is used to
optionally establish the
OpenWorks interpreter to
be used when manipulating
data in an OpenWorks
project. You are not
required to select an
interpreter, but are strongly
encouraged to do so if you
intend to create any
OpenWorks interpretation
data in the project.

Following outlines the
behavior when setting the
Interpreter credential:

It affects which default Well
Velocity to use for a Well.

It affects the retrieval of the
Color attribute for a
GeologicFault/Horizontable
since multiple interpreters
can have different colors for
the same fault/horizon
name.

It is used to populate the
interpreter attribute in the
OpenWorks project when
inserting into the following
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Data
Source
Type

 Credential Credential
Scope

Required Description

tables:

l EarthModel (only for
R5000)

l GeologicFault

l HorizonGrid1dProperty

l HorizonGrid1dSetPropert
y

l HorizonGrid2dProperty
(seismicandnon-seismic
grids)

l LineGeometry2dSet

l LineGeometry2d

l SeismicGeometry3d

l FaultPolylineSet

l HorizonFaultBoundarySe
t

l Horizon

Source Priority Project No The Source Priority
credential enables you to
optionally create and
associate a source priority
list with the project. A
source priority list defines
an ordered list of preferred
interpreters used when
retrieving like data. It is
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Data
Source
Type

 Credential Credential
Scope

Required Description

considered by business
logic in the OpenWorks data
access libraries. It affects
decisions used in
determining which well pick
is used if picks have the
same name but different
interpreters.

Petra Project Password Project Maybe The Petra project password.
This credential is required if
the Petra project has been
password protected.

PPDM User Data source Yes The Oracle user account
name. This credential may
have a default value if your
OpenSpirit administrator
enabled the Use As Default
for Users option when
configuring your PPDM data
source.

Password Data source Yes The Oracle account
password. This credential
may have a default value if
your OpenSpirit
administrator enabled the
Use As Default for Users
option when configuring
your PPDM data source.

Recall n/a
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Data
Source
Type

 Credential Credential
Scope

Required Description

SEGY n/a

Studio User Data source Maybe The Oracle or SQL Server
database account name.
This credential is not
needed if the Studio data
source was configured to
use Windows
authentication.

Tip: The user credential
determines the projects
that are visible in all
OpenSpirit data source
selection Windows. The
data source appears not
to contain any projects
until the user and
password credentials
have been entered and
saved.

Password Data source Maybe The Oracle or SQL Server
database account
password. This credential is
not needed if the Studio
data source was configured
to use Windows
authentication.

QA_
BusinessProject

Project No This optional credential is
provided to work around a
problem in the Studio SDK
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Data
Source
Type

 Credential Credential
Scope

Required Description

that is encountered when
Studio has been configured
to require quality tags. The
value of this credential used
as the default value for the
Business Project property
on Seismic Folder,
Interpretation Folder, and
Horizon Interpretation
domain objects that are
automatically created by
the Studio SDK.

QA_Comment Project No This optional credential is
provided to work around a
problem in the Studio SDK
that is encountered when
Studio has been configured
to require quality tags. The
value of this credential used
as the default value for the
Comments property on
Seismic Folder,
Interpretation Folder, and
Horizon Interpretation
domain objects that are
automatically created by
the Studio SDK.

QA_
ConfidenceFactor

Project No This optional credential is
provided to work around a
problem in the Studio SDK
that is encountered when
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Data
Source
Type

 Credential Credential
Scope

Required Description

Studio has been configured
to require quality Tags. The
value of this credential used
as the default value for the
Confidence Factor property
on Seismic Folder,
Interpretation Folder, and
Horizon Interpretation
domain objects that are
automatically created by
the Studio SDK.

QA_DataStatus Project No This optional credential is
provided to work around a
problem in the Studio SDK
that is encountered when
Studio has been configured
to require quality tags. The
value of this credential used
as the default value for the
Data Status property on
Seismic Folder,
Interpretation Folder, and
Horizon Interpretation
domain objects that are
automatically created by
the Studio SDK.

Data Source Host/Account
The host computer and account used to run OpenSpirit data connector processes is
determined by your Host/Account settings. The host and account that used to start data
connector processes for each data source is shown in the Host/Account column. Data
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sources with <Default> next to the data source run using the host and account specified
on the Platform Defaults panel.

A different host and/or account can be used for specific data sources by clicking the
<Default> hyper link next to the data source. This opens the Set Server Activation
window for the data source.

Uncheck the Use default option to enable selecting a specific host and account
combination to use when accessing the data source. The dropdown account selection list
contains all the accounts listed on the User Setup Wizard's Host Account Settings panel.

A specific host and account can be set on multiple data sources by selecting multiple data
sources in the Data Source Settings window and pressing the Set host and account for
selected icon in the Data Source Settings panel tool bar. This opens the Set Server
Activation window for setting the host/account for the selected data sources. The selected
data sources must be supported to run on a common operating system platform.
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Email Settings
The Email Settings panel of the User Setup Wizard is used to enter email account
information that can be used by the Copy Job Manager and Scan Job Manager tools to
send email when your copy jobs and scan jobs complete.

Tip: The email settings are optional. They are only used if you run Copy Manager
or Scan Utility jobs. Do not enter email settings if you do use Copy Manager or
Scan Utility but do not want to receive email notifications when your jobs
complete.

Tip: The Email Settings tab of the User Setup Wizard enabled if your OpenSpirit
administrator has configured your OpenSpirit master installation's SMTP Server
setting. Contact your OpenSpirit installation administrator if you cannot enter
email settings and would like to receive copy or scan job completion email
notifications.

The from email address is optional. It is used as the email sender's address if supplied.
The sender defaults to the address determined by your company's email server if you do
not enter a value.
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The email account password field is present if your OpenSpirit administrator configured
your OpenSpirit installation to require an email password to send email. The field is not
visible if a password is not required by your company's email server in order to send email.

At least one email address should be entered in the recipient email addresses field.
Multiple email addresses may be entered using a comma between email addresses.

The image below shows an example of a typical completed email settings tab.
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Data Selector Overview
Data Selector tool is a data selection and query utility that presents a tabular summary of
selected attributes associated with the data types that are supported by the OpenSpirit
Framework. The Data Selector can be used to browse data from any data source supported
by the OpenSpirit framework. The Data Selector is also used to send data selection events
to applications that support listening for OpenSpirit data selection events.

This Data Selector help document contains a Getting Started section that provides an
overview of the steps needed to quickly get started browsing data in the Data Selector. The
Getting Started section is followed by sections that go into more detail about data models
and how to use the more advanced features of the Data Selector.

The OpenSpirit Desktop preferences settings window can be used to change various default
settings for the Data Selector.
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Getting Started
This section of Getting Started covers the following topic:

Starting the Data Selector
The Data Selector tool is accessed from the OpenSpirit Desktop by clicking the Data
Selector tool bar icon or by choosing the Tools > Data Browser > Data Selector menu
item. This causes a Data Source Selection window to open. The Data Source Selection
window is used to select the sources of data that available to the Data Selector. The Data
Selector tool opens when the Data Source Selection window is closed.

It is possible to open multiple Data Selector Windows within the OpenSpirit Desktop.
Additional Data Selector Windows are opened by clicking the Data Selector tool bar icon
or by choosing the Tools > Data Browser > Data Selector menu item while a Data
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Selector window is already visible. The new Data Selector window's tab shows that a
number is parenthesis that indicates it is an additional Data Selector.

Multiple Data Selector Windows are useful for quickly switching between different data
source selections or when positioning the Windows side by side to compare data from
different data sources. See the OpenSpirit Desktop help guide for information about
window layout management within the desktop.

Selecting Data Sources
The Data Source Selection window opens automatically when activating the Data Selector
tool. The Data Source Selection window is used to select the sources of data that queried
by the Data Selector. It can also be opened by clicking the Select Data Sources icon in
the Data Selector tool bar.
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See the Data Source Selection Window section of this guide for details of using the Data
Source Selection window.

Browsing Data
The Data Selector presents a tabular view of the data queried from selected data sources
and projects. Data types are organized into logical groupings (for example, Well, Seismic,
Culture) which appear as tabs with bold font across the top of the Data Selector window.
Clicking one of the group tabs causes the data types within the selected group to display in
the second row of tabs.
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A double right arrow symbol   is displayed to the right of the last visible tab if there are
too many tabs to display in the available window width. The number next to the double
right arrow symbol indicates how many tabs have been hidden due to insufficient window
width.

Clicking the hidden tab indicator displays a dropdown menu, which can be used to select
any of the hidden tabs.

The data type tabs provide a view of the individual data items that reside in the data
sources that were selected from the Data Source Selection window. Each data type view
has a scope. The scope determines the subset of data that is available for display in the
data type view. See the Scoping Views section for more information about data type view
scopes.

Tip: The data type groups and data types that are available for selection are
determined by the OpenSpirit data model, native data model, or model view
that was selected in the Data Source Selection window.
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Sending Data Selection Events
The primary use of the OpenSpirit Data Selector, in addition to browsing data sources, is to
send a selection of one or more data items to another application. This is accomplished
using data selection events or drag and drop. Data selection events are sent by selecting
one or more rows in the currently selected data type view and clicking the data selection
event send button in the data type view's tool bar. This sends the identity of all
selected rows to any application that you are running that is listening for OpenSpirit data
selection events.

Each application that is listening for data selection events react to the event in a way
appropriate for that application. Each application determines which data type it listens for
and what it does when the event is received. Many applications that listen for OpenSpirit
data selection events only listen for selections of data types that are defined in the
OpenSpirit common model. Selection events for native model data types such as
OpenWorks or Studio native model types are ignored by applications that only listen for
selection of OpenSpirit common model data types. The identity of a row in a data type
view is represented by an OpenSpirit data key.
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Data Selector Actions
This section of Data Selector Actions covers the following topic:

Data Selector Tool Bar
The Data Selector tool bar contains buttons that perform actions that may affect the
overall Data Selector. These actions are described in the following sections of this help
guide. The tool bar resides in the upper right-hand corner of the Data Selector window.

Refresh Button
The refresh tool bar button refreshes the content of the currently selected data type
view. The refresh button produces the same result as pressing the query button on the
currently displayed data type view.

Save Data Selector Button
The save tool bar button saves the current state of the Data Selector to a file. See the
Saving the Data Selector State section of this help guide for details.
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Save As Data Selector Button
The save as tool bar button saves the current state of the Data Selector to a file of your
choosing. See the Saving the Data Selector State section of this help guide for details.

Select Data Sources Button
The select data sources tool bar button opens the data source selection window. See
the Selecting Data Sources section of this help guide for details.

Open Data Selector File Button
The open Data Selector file tool bar button opens a file selection window that is used to
select a Data Selector saved state file that has been previously created using the save or
save as button. See the Saving the Data Selector State section of this help guide for details.

Revert Data Selector Button
The revert tool bar button resets the Data Selector to its original factory settings. See
the Resetting the Data Selector section of this help guide for details.

Select Data Types Button
The select data types tool bar button opens the data type selection window used to
select the data type views that you want displayed in the Data Selector. See the Selecting
Data Types to Display section of this help guide for details.

Select Spatial Scope Button
The select spatial scope tool bar button opens the spatial scope selection window used
to select a bounding box or polygon used to spatially constrain data displayed in the Data
Selector. See the Setting a Spatial Scope section of this help guide for details.
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Toggle Event Listening Button
The toggle event listening tool bar button is used to turn listening for events on and off in
the Data Selector. The button appears with a lightning bolt when event listening is
enabled. The button appears without a lightning bolt when listening is disabled. See
the Listening for Data Selection Events section of this help guide for details.

Data Selector Settings Button
The Data Selector settings tool bar button opens the Data Selector Settings window.
See the Data Selector Settings section of this help guide for details.

Help Button
The help tool bar button is always enabled. Clicking the help button opens this help
guide.

Saving the Data Selector State
The state of the Data Selector can be saved to a file so that it can be restored later. The
state that is saved includes:

l Selected data sources

l Selected model view

l Coordinate system and units preferences

l Displayed data type groups and data types

l Data type view column customizations (column order, column display format, and
so on)

l Data type view scope selections

l Data type query filters

l Any rows that are selected in any of the data type views

The Data Selector state is saved by clicking the save icon in the Data Selector tool bar.
The Data Selector state is saved in a file named DataSelector.ospdataselector in the
OpenSpirit folder in your home directory.
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The state can be saved to a different file by clicking the save as icon in the Data
Selector tool bar and entering a new file name in the file selection window that appears.

The Data Selector state can also be saved using the OpenSpirit Desktop's File > Save or
File > Save As... menu items when the Data Selector window is the active window in the
OpenSpirit Desktop.

Restoring the Data Selector State
The Data Selector state can be restored to a previously saved state by clicking the file open

icon in the Data Selector tool bar and selecting a previously saved Data Selector state
file having a .ospdataselector file name extension. The information that is restored is
described in the Saving the Data Selector State section of this help guide.

The Data Selector state can also be restored using the OpenSpirit Desktop's File > Open
menu item. Select a previously saved Data Selector file having an .ospdataselector file
extension.



TIBCO OpenSpirit® Runtime User Guide

78 | Data Selector Actions

Resetting the Data Selector
The state of the Data Selector can be reset to its default state by clicking the revert icon

. This clears out any data source selection and restores all of the Data Selector settings
to the default values.

Note: Save the Data Selector state to a file before clicking the revert icon if you
have performed any significant customizations that you do not want to lose.

Selecting Data Sources
The Data Source Selection window opens automatically when activating the Data Selector
tool. The Data Source Selection window is used to select the sources of data that queried
by the Data Selector. It can also be opened by clicking the Select Data Sources icon in
the Data Selector tool bar.
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See the Data Source Selection Window section of this guide for details of using the Data
Source Selection window.

Selecting Data Types to Display
The Data Type Selection window is used to control which data type groups and which data
type views are visible in the Data Selector. The Data Type Selection window is displayed by
clicking the Select Data Types icon in the Data Selector tool bar.
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The Data Type Selection window presents the data type groups and data types that are
defined in the data model or model view selected in the Data Source Selection window.
Select or deselect the data type groups and/or data types that you wish to display in the
Data Selector.

Setting a Spatial Scope
A spatial scope can be set on the Data Selector, which can be used to limit the query
results using spatial filters. The spatial scope defines a bounding box or a set of polygons
that should be used by any spatial filters set on individual data type views. The individual
data type spatial filters are controlled using the Query Filter window for data types having
one or more spatial attributes.

The Spatial Scope Selection window can be opened by clicking the Select Spatial Scope
icon in the Data Selector tool bar. The Spatial Scope Selection window presents two
ways of establishing a spatial filter scope.
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Bounding Box Spatial Scope

Clicking the Bounding Box spatial scope option displays a window used to enter a
bounding box. The bounding box must be defined relative to the desktop coordinate
system preference. A button is provided as a shortcut for opening the desktop
coordinate system preference setting window. A desktop coordinate system preference
must be selected before entering the bounding box. The bounding box can be entered
once a coordinate system has been selected. It can be entered either by typing in a lower
left corner point and an upper right corner point, or it can be entered by sending an
OpenSpirit GIS feature selection event from any OpenSpirit enabled application that can
send GIS events (for example, ArcGIS Desktop with TIBCO OpenSpirit Extension for ArcGIS,
Petrel with TIBCO OpenSpirit Adapter for Petrel, and so on). A bounding box is calculated
to encompass all of the features in the received GIS feature selection event.



TIBCO OpenSpirit® Runtime User Guide

82 | Data Selector Actions

GIS Feature Polygons Spatial Scope

Clicking the GIS Feature Polygons spatial scope option displays a window used to select
one or more polygons to be used as the spatial scope. The polygons must be selected by
sending an OpenSpirit GIS feature selection event containing polygon features from any
OpenSpirit enabled application that can send GIS events. A desktop coordinate system
preference must be set in order to enable listening for GIS feature events. An edit button

is provided as a shortcut for opening the desktop coordinate system preference setting
window.

GIS event listening enabled once a coordinate system preference has been set. Polygon
features from received events displayed in a table allowing individual polygon features to
be selected for inclusion in the spatial scope.
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Listening for Data Selection Events
The Data Selector can listen for data selection events as well as sending data selection
events. Data selection event listening is enabled by clicking the OpenSpirit event listing
icon in the Data Selector tool bar. The icon changes to display a lightning bolt to
indicate that event listening is enabled. Data selection events sent from other applications
cause rows to be added to corresponding data type views in the Data Selector. Rows of
data added by data selection event reception appear with a lightning bolt icon in the

left-most column.
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Data selection events that refer to data that resides in data sources that are not in the Data
Selectors current data source selection scope causes a question window to appear.

Pressing the Yes button causes the Data Selector's data source selection to be expanded to
include all data sources referenced in the received event. Pressing the No button causes
the received event to be ignored.
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Tip: The Data Selector only listens for selection events containing data keys that
are for data types that belong to the data model that is being viewed. For
example, if the Data Selector is viewing data types that belong to the
OpenWorks native model and data selection listening is turned on, selection
events for OpenSpirit common model data types are ignored. The event sender
and the event receiver must both be working with the same data model type
and version.

Data Selector Settings
The Data Selector Settings window displays summary information about the current state
of the Data Selector. It is also used to select the coordinate system and units preferences
for the Data Selector. The settings window is opened by clicking the View Data Selector
Settings icon in the Data Selector tool bar. The settings window shows the data model,
model view, spatial scope, data source selection, coordinate system, and unit’s preferences
currently enabled in the Data Selector.
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The default behavior of the Data Selector is to honor the coordinate system and units
preferences set in the OpenSpirit Desktop preferences. However, the Data Selector Settings
window can be used to override the coordinate system or unit preferences used by the
Data Selector. Overriding at the Data Selector level is typically done when there is a need
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to use multiple Data Selectors and have them use different coordinate system or unit
preferences.
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Data Type Actions
This section of Data Type Actions covers the following topic:

Data Type View Tool Bar
The data type view tool bar contains buttons that perform actions that only affect the
currently selected data type view.

View Scope
The view scope selection is used to display rows of data based on row selections made on
related data type views. See the Scoping Views section of this help guide for details.

Row Limit
The row limit value constrains the number of rows that are displayed in the data type view.
See the Row Limit section of this help guide for details.

Query Button
The query button runs the query against the selected data sources and displays the
resulting data rows. See the running Queries section of this help guide for details.

Select All Rows Button
The select all rows button selects all of the rows that are currently displayed in the data
type view. See the Row Selection section of this help guide for details.
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Clear All Row Selections Button
The clear all row selections button de-selects all selected rows in the data type view. See
the Row Selection section of this help guide for details.

Apply a Query Filter Button
The apply a query filter button opens the query filter window. The query filter window is
used to create filters that can be used to constrain the rows of data that are displayed in
the data type view. See the Query Filter Window section of this help guide for details.

Select Columns to Display Button
The select columns to display button open the column display selection and ordering
window. See the Configuring Data Selector Tabs and Columns section of this help guide for
details.

Send Data Selection Event Button
The send data selection event button sends a data selection event containing keys for all
the selected rows in the data type view. See the Sending Data Selection Events section of
this help guide for details.

Remove Received Data Selections Button
The remove received data selections button removes all rows that are selected and
originated from a received data selection event. See the Removing Received Data
Selections section of this help guide for details.

Scoping Views
Each data type view displays the rows of data returned by querying the selected data
sources. The query used to populate the view can be applied to the entire data source
selection, or it can be applied to a subset of data based on selected rows in a related data
type view. The View Scope option is used to control this query scoping behavior. The View
Scope drop down list contains a list of all the related data types that are candidates for
scoping the view. The dropdown content differs for each data type view. All data type
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views contain Data Source as one of the options. Selecting the Data Source option causes
all data in the selected data sources to be shown without regard for any row selections
that may exist on any related data type views.

The following image shows the View Scope options for the OpenSpirit Pick data type view.
The Pick data type query can be scoped to rows selected in the Project data type view,
the Well data type view, or the Well Details data type view. Scoping the Pick view to the
Well view causes the Pick query to return only picks that belong to wells that are currently
selected in the Well view. The query may also be further constrained by the Row Limit
setting and any Query Filter that may also be set on the Pick data type view.

A warning message is displayed when running a data type query where the View Scope is
set to a data type where no rows are currently selected. The following image shows an
example of setting the Pick data type view's scope to Well when no rows are currently
selected in the Well data type view. This warning is given to remind the user why no pick
data rows are being returned by the query. Checking the Do not show this dialog again
option on the warning prevents this warning from being shown for any data type view.
Display of this warning can be re-enabled using the Data Selector View preference window.
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Row Limit
The Row Limit setting is provided to protect against flooding the Data Selector with large
numbers of data rows when browsing data sources that contain large numbers of data
items. The Row Limit constrains the number of data rows returned by data type view
query.

Setting the limit to zero or blanking it out entirely cause all query rows to be returned.

Tip: The default row limit for all tabs is controlled by the Limit number of rows
option in the Data Selector preference settings.

Executing Queries
Data Selector queries are performed automatically when needed unless the Data Selector
Auto Query preference setting is disabled. Click the Query execution icon in the data
type view tool bar to force a query execution. A progress window opens during the query
execution. Click the Run in Background button to dismiss the progress window and allow
the query execution to continue. Click the Cancel button to dismiss the progress window
and end the query execution.
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Checking the Always run in background option causes the progress window to never
appear and to always allow the query to run in the background. Background queries can
still be canceled by clicking the progress icon in the lower right corner of the OpenSpirit
Desktop window.

This opens the desktop's Progress View window. Click the cancel button to the right of
the progress bar to cancel the running query.

The status area below the query result rows shows the current Auto Query option state.
False indicates that the Auto Query option is not selected. True indicates that Auto Query is
enabled.

Counting Rows
The Row Count feature is provided to aid in browsing large data sources. Clicking the Row
Count icon in the data type view tool bar runs a count query instead of querying for the
actual row data. Most data sources can run count queries much faster than queries that
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return the row data. The Auto Query option should be deselected to make effective use of
count queries. Otherwise the normal row data query ran automatically thereby negating
much of the benefit from performing a count query. The count query result is displayed in
an information window that opens when the count query execution completes.

Row Selection
The rows of data returned by queries in a data type view can be selected in a variety of
ways. All rows can be selected by clicking the Select all rows icon in the data type view
tool bar. Clicking the Clear all row selections icon deselects any currently selected
rows. Rows can also be selected using the computer mouse by clicking a single row.
Holding down the shift key while clicking a row selects all rows between the clicked row
and the last selected row. Holding down the control key while clicking a row toggles the
selection state of the clicked row.

Selected rows appear highlighted.

The status area below the rows indicates the number of rows and the number of rows that
are currently selected.
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Query Filters

Setting Query Filters

Query filters are used to restrict the data rows returned by the data type view query. Query
filters are added to a data type view by clicking on the Query filter icon in the data type
view tool bar. This will open up the Query Filter window for the current data type view. For
those familiar with the SQL database query language, the Query Filter window is used to
construct the SQL WHERE clause that will be used when executing the query to populate
the data type view with data rows.
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The Enable query filter checkbox at the top left corner of the Query Filter window can be
used to toggle the filter on or off without having to remove it.

Query Filter Attributes

A table of all the attributes available for display appears across the top third of the Query
Filter window. Selecting the Show all attributes option will add all of the attributes that
exist in the model view to the table, including attributes that are not marked as available
in the model view.
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The attributes shown in the table are available for use in constructing the filter. The
attribute table shows the attribute's display name and data type. The Relationship column
in the attribute table shows the data model data type that the attribute actually belongs
to. This is needed because the data type view may represent a join between multiple
related data types in the data model that you are viewing. Click the information icon to
open a window that shows a description of the attribute's purpose.

Click on the button next to any attribute to add it to the filter expression table that
appears in the middle section of the Query Filter window.

Filter Expressions

Query Filter Expressions
Query filter expressions are tests that are applied to each row of data to decide it the row
of data should be displayed in the Data Selector or if it should be omitted. The filter
expression table displayed in the center section of the Query Filter window is actually a
representation of the SQL WHERE clause that will be added to the query executed by the
Data Selector against the OpenSpirit data connectors to populate the data type view in the
Data Selector.
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An optional comment field is provided so you can document the purpose of each filter
expression.

Clicking on the View Query button will display a window that shows the SQL

that the data selector will execute to populate the data type view in the Data Selector.

Tip: Note, the attribute names that appear in the SQL will not match the
attribute display names shown in the Data Selector. The SQL contains the actual
data model table and column names. The names shown in the query filter
window are the model view names or data model display names.

Attributes can be removed from the filter expression table by clicking on the remove icon
. The up and down arrows are used to reorder query expressions in the table.
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Query Filter Operators
The relational operator to be used in the filter expression should be selected when adding
an attribute to the filter expression. The operators that are available for selection depend
on the attribute's data type.

The following table shows the operators that can be used for each attribute data type.

Operator Description Supported
Data Types

= The attribute must be exactly equal to a specified
value.

Use of the equals operator with FLOAT, FLOAT_
QUANTITY, DOUBLE, and DOUBLE_QUANTITY
attributes is strongly discouraged. Floating point
values are subject to rounding errors during unit
conversion. Also, the values presented in applications,
including the Data Selector, are typically not showing
the full precision of the values.

Consider using a less than expression combined with
a greater than expression to create a tolerance range
when filtering on floating point values.

BIGINT
BOOLEAN
CHAR
DATAKEY
DATE
DOUBLE
DOUBLE_
QUANTITY
FLOAT
FLOAT_
QUANTITY
INTEGER
SMALLINT
TIME
TIMESTAMP
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Operator Description Supported
Data Types

TINYINT
UNIT
VARCHAR

= Attribute The attribute must be exactly equal to the value of
another attribute of the data type. The other attribute
must have the same data type in order for it to appear
in the value selection list.

BIGINT
BOOLEAN
CHAR
DATAKEY
DATE
DOUBLE
DOUBLE_
QUANTITY
FLOAT
FLOAT_
QUANTITY
INTEGER
SMALLINT
TIME
TIMESTAMP
TINYINT
VARCHAR

!= The attribute must be different from a specified value.
Use of the not equals operator with FLOAT, FLOAT_
QUANTITY, DOUBLE, and DOUBLE_QUANTITY
attributes is strongly discouraged. Floating point
values are subject to rounding errors during unit
conversion. Also, the values presented in applications,
including the Data Selector, are typically not showing
the full precision of the values.

Consider using a less than expression combined with
a greater than expression to create a tolerance range
when filtering on floating point values.

BIGINT
CHAR
DATE
DOUBLE
DOUBLE_
QUANTITY
FLOAT
FLOAT_
QUANTITY
INTEGER
SMALLINT
TIME
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Operator Description Supported
Data Types

TIMESTAMP
TINYINT
UNIT
VARCHAR

< The attribute must be less than a specified value. A
lexical comparison is used when comparing VARCHAR
attributes.

BIGINT
CHAR
DATE
DOUBLE
DOUBLE_
QUANTITY
FLOAT
FLOAT_
QUANTITY
INTEGER
SMALLINT
TIME
TIMESTAMP
TINYINT
VARCHAR

> The attribute must be greater than a specified value. A
lexical comparison is used when comparing VARCHAR
attributes.

BIGINT
CHAR
DATE
DOUBLE
DOUBLE_
QUANTITY
FLOAT
FLOAT_
QUANTITY
INTEGER
SMALLINT
TIME
TIMESTAMP
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Operator Description Supported
Data Types

TINYINT
VARCHAR

IN The attribute must have an exact match with one
value in a list of comma separated values

Note: You can paste multiple lines of text from the
system clipboard into the value field and the multiple
lines will be converted to a comma separated list of
values.

BIGINT
CHAR
DATAKEY
DOUBLE
FLOAT
INTEGER
SMALLINT
STRING_
ARRAY
TINYINT
VARCHAR

NOT IN The attribute must not have an exact match with any
value in a list of specified values.

Note: You can paste multiple lines of text from the
system clipboard into the value field and the multiple
lines will be converted to a comma separated list of
values.

BIGINT
CHAR
DATAKEY
DOUBLE
FLOAT
INTEGER
SMALLINT
STRING_
ARRAY
TINYINT
VARCHAR

LIKE The attribute must partially match a specified value.
Partial match is specified using special wildcard
characters.

VARCHAR
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Operator Description Supported
Data Types

Wildcard
Character

Description

% Matches any string of zero or more
characters.

_ Matches any single character

For example:

1. The expression value ABC% will match any value
that begins with ABC. It will match ABCDEF,
ABCD, and ABC. It will not match DABC because
the string must begin with the character A.

2. The expression value %ABC will match any value
that ends with ABC. It will match DEFABC DABC,,
and ABC.

3. The expression value %ABC% ABC DABCEF
ABCDEF DEFABC will match any value that
contains anywhere in the value. It will match ,,,
and ABCCBA . It will not match or ADBEC.

4. The _ character will match any single character. It
will not match zero characters.Therefore the
expression value ABC_ will match ABCD, ABCE,
but will not match ABCDE or ABC.

Any number of % and _ wildcards can be used in
the expression value.

NOT LIKE The attribute must not partially match a specified
value. Partial match is specified using the special
wildcard characters described above in the
description of the LIKE operator.

VARCHAR
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Operator Description Supported
Data Types

IS NULL The attribute cannot have any value in the database. <all types>

IS NOT NULL The attribute can have any value except the null
value.

<all types>

SIMILAR TO The attribute must partially match a specified value.
Partial match is specified using regular expression
syntax.

VARCHAR

NOT SIMILAR
TO

The attribute must not partially match a specified
value. Partial match is specified using regular
expression syntax.

VARCHAR

WITHIN The attribute must be spatially within the spatial
scope that has been set on the OpenSpirit Desktop.

Spatially within means the geometry of the attribute
lies in the interior of the Data Selector's spatial scope.

This operator conforms to the spatial relationship
predicates defined in the OpenGIS Simple Feature
Access specification.

GEOMETRY

EQUALS The attribute must be "spatially equal" to the spatial
scope that has been set on the OpenSpirit Desktop.

Spatially equal means the geometries are
topologically equal.

This operator conforms to the spatial relationship
predicates defined in the OpenGIS Simple Feature
Access specification.

GEOMETRY

DISJOINT The attribute must be "spatially disjoint" from the
spatial scope that has been set on the OpenSpirit
Desktop.

GEOMETRY
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Operator Description Supported
Data Types

Spatially disjoint means the geometries have no point in
common.

This operator conforms to the spatial relationship
predicates defined in the OpenGIS Simple Feature
Access specification.

TOUCHES The attribute must "spatiallytouch" the spatial scope
that has been set on the OpenSpirit Desktop. Spatially
touch means the geometries have at least one
boundary point in common, but no interior points.
This operator conforms to the spatial relationship
predicates defined in the OpenGIS Simple Feature
Access specification.

GEOMETRY

OVERLAPS The attribute must "spatiallyoverlap" the spatial scope
that has been set on the OpenSpirit Desktop.

Spatially overlap means the geometries share some
but not all points in common, and the intersection has
the same dimension as the geometries themselves.

This operator conforms to the spatial relationship
predicates defined in the OpenGIS Simple Feature
Access specification.

GEOMETRY

CROSSES The attribute must "spatially cross" the spatial scope
that has been set on the OpenSpirit Desktop.

Spatially cross means the geometries share some but
not all interior points,and the dimension of the
intersection is less than that of at least one of the
geometries.

This operator conforms to the spatial relationship
predicates defined in the OpenGIS Simple Feature
Access specification.

GEOMETRY
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Operator Description Supported
Data Types

INTERSECTS The attribute must "spatially intersect" the spatial
scope that has been set on the OpenSpirit Desktop.

Spatially intersect means the geometries have at least
one point in common.

This operator conforms to the spatial relationship
predicates defined in the OpenGIS Simple Feature
Access specification.

GEOMETRY

CONTAINS The attribute must "spatially contain" the spatial
scope that has been set on the OpenSpirit Desktop.

Spatially contains means the geometry of the Data
Selector's spatial scope lies in the interior of the
attribute.

This operator conforms to the spatial relationship
predicates defined in the OpenGIS Simple Feature
Access specification.

GEOMETRY

Query Filter Values
Most filter expression operators also require a value to be entered or selected. The
exceptions are the IS NULL, IS NOT NULL, and the spatial operators WITHIN, EQUALS,
DISJOINT, TOUCHES, OVERLAPS, CROSSES, INTERSECTS, and CONTAINS. These
operators do not require an expression value to be entered in the filter.
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Values for filter expressions using the = Attribute operator are entered by selecting one of
the attributes in the dropdown. The dropdown contains all of the attributes that have the
same data type as the expression attribute.

Values for other operator types are entered in different ways depending on the attribute
data type and the expression operator that is selected.

VARCHAR attributes

Values for filter expressions on VARCHAR attributes can be entered by typing in the Value
field, or by clicking on the adjacent Lookup button which will query the Data

Selector's current data source(s) and display a distinct set of values that currently exist in
the data source(s). A value can then be selected from the lookup list. The lookup selection
list for the IN and NOT IN operators for VARCHAR attributes allows for multiple values to
be selected. The values should be separated by commas when entered manually.

Tip: You can paste multiple lines of text from the system clipboard into the
value field when using the IN or NOT IN operator and the multiple lines will be
converted to a comma separated list of values.

The list displayed by clicking on the Lookup button will be either a complete list of
allowable values, or it will be a list of the distinct set of values that currently exist in the
selected data source(s). The lookup list for attributes that are constrained to a list of
allowable values will appear as a scrolled list of all the possible values for the attribute.
The title bar above the list will contain the attribute name followed by Allowable Values.
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The allowable values list provides no indication which values are currently in use in the
data source(s). All possible values are shown.

The lookup list for attributes that are not constrained to a set of allowable values appears
as a scrolled list that contains the distinct list of values that are currently in use in the data
source(s). The title bar above the list will contain the attribute name followed by Unique
Values. A Row Limit field and a Get Values button appear on distinct values lists. They do
not appear on allowable values lists.
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The Row Limit field below the list of values provides protection against attempting to
display a very large number of values. A larger or smaller number of values can be shown
in the list by entering a different row limit value and clicking on the Get Values button to
re- query the data source(s).

STRING_ARRAY attributes

Values for filter expressions on STRING_ARRAY attributes can be entered when using the
IN or the NOT IN operator. Values are entered by typing in the Value field. A single value
can be entered or a comma separated list of values can be entered.

Tip: You can paste multiple lines of text from the system clipboard into the
STRING_ARRAY value field and the multiple lines will be converted to a comma
separated list of values.

INTEGER, BIGINT, TINYINT, and SMALLINT attributes

Values for filter expressions on integer attributes are entered by typing an integer number
in the Value field. The value must be a positive or negative integer.

FLOAT and DOUBLE attributes

Values for filter expressions on real number attributes are entered by typing a number in
the Value field. The value must be a positive or negative number expressed in decimal
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number format with a period character separating the whole number part from the
fractional number part.

FLOAT_QUANTITY and DOUBLE_QUANTITY attributes

Values for filter expressions on FLOAT_QUANTITY and DOUBLE_QUANTITY attributes are
entered by typing a number in the Value field. A unit of measure selection is also required
in order for the numeric value to be fully defined. Unit conversions will be performed if
needed when applying the filter during query execution. The unit selected in the filter
expression will not affect how the values returned by the query are displayed in the Data
Selector. The unit is only used to insure proper unit handling when applying the filter.

TIMESTAMP attributes

Values for filter expressions on TIMESTAMP attributes must be entered using a specialized

date/time selection window. Pressing the Select button next to the filter
expression displays the date/time selection window.

Clicking on the month, year title will zoom the calendar out for selecting any month in the
year.
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Clicking on the year title will zoom the calendar out even more for selecting any year
within the decade. Clicking on the decade will zoom the calendar out to select a century.
Century selection is the zoom limit.

BOOLEAN attributes

The value used for BOOLEAN attribute is selected from a dropdown that contains TRUE
and FALSE.

GEOMETRY attributes

The value used for GEOMETRY attributes is determined by the data selector's spatial
scope. The value is entered using the Data Selector's spatial scope selector. The spatial

scope selector is opened by clicking on the Select Spatial Scope icon in the Data
Selector tool bar. See the Setting a Spatial Scope section of this guide for information
about setting the data selector's spatial scope.

UNIT attributes

Values for filter expressions on UNIT attributes must be entered using a specialized unit

selection window. Pressing the Lookup button next to the filter expression
displays the unit selection window.
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Select a unit measurement in the top section of the window to display the units that
belong to a unit measurement category. Select the desired unit in the lower section of the
window.

DATAKEY attributes

Values for filter expressions on DATAKEY attributes must contain a valid OpenSpirit data
key string. Data keys are represented using XML. Data key strings can be pasted into the
Value field using the system clipboard's copy/paste feature. Data key strings can be
obtained from a variety of sources. They can be obtained by dragging and dropping rows
from the data selector to a Microsoft Word or Excel document. They can sometimes be
obtained from Copy Manager logs or from OpenSpirit data connector log files.

Tip: Filtering using data key attributes is an advanced feature. It is expected to
primarily be used by software developers.



TIBCO OpenSpirit® Runtime User Guide

112 | Data Type Actions

Query Filter Predicate
The query filter expression Predicate selector appears when adding more than one
attribute to the query filter expression table. The predicate indicates how the filter
expression should be logically combined with the expression immediately below it. The
predicate choices are AND and OR.

The AND predicate combines the expressions by requiring both to evaluate to true in order
for a data row to be returned by the query. Combining two expressions using the OR
predicate will return a data row if either expression evaluates to true. Expressions are most
commonly combined using the AND predicate.

It is highly recommended to use the grouping feature when mixing use of AND and OR
predicates in a query filter. The grouping feature is used to impose an evaluation order on
the combined expressions. Expression grouping can be enabled by selecting the Use
Grouping option above the filter expression table. Selecting the grouping option causes
two additional columns to appear in the filter expression table. The columns contain drop
down selectors that are used to add parentheses around the expressions. Up to two levels
of parentheses nesting can be selected. The opening and closing parentheses count must
match.
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A Validate Query button is provided to test the filter expressions to insure

parentheses matching. The validation also insures that expression values have been
entered where required. Validation will run automatically when closing the Query Filter
window using the Ok button.

Tip: Do not use OR predicates unless it is absolutely necessary when working
with large data sources. They often result in poor query performance unless
accompanied by a top-level filter expression using the AND predicate.

Query Filter View Scope & Spatial Filtering

The bottom section of the Query Filter window contains options for selecting the View
Scope of the data type view and for controlling spatial filtering. The View Scope selection
option is the same as on the data type view tool bar. The Enable spatial scope option
turns spatial filtering on or off. A spatial scope must be set on the desktop in addition to
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enabling it in the Query Filter window for spatial filtering to be performed. The Spatial
Attribute selection determines the attribute that the spatial filtering will be applied to. All
spatial attributes available for display in the data type view will appear in this dropdown
selector.

Configuring Data Selector Tabs & Columns
The column display can be turned on and off in a data type view using the attribute
selection window. Click the Select columns to display icon in the data type view tool

bar to open the attribute selection window.
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Select or deselect the checkbox in the Displayed column to add or remove attribute
columns from the data type view. A select all and a select none icon is provided in

the window's tool bar.

The text that appears for the column headings of the data type view can be changed by
clicking in an attribute's Display Name field and replacing the existing display name text.

Clicking the description icon for an attribute opens a window that can be used to enter
a description of the attribute. The description appears as a tool tip when hovering the
mouse pointer over the attribute's column header in the data type view window.

Some attribute data types provide display format settings that can be customized for
specific attributes. Attribute-specific formatting is available for an attribute if an edit icon

is shown in the Format column for the attribute. The number of characters displayed for

VARCHAR attributes can be limited. The display format of numeric attributes, color
attributes, geometry attributes, and date/time attributes can also be customized. Formats
set at the attribute level override the Data Display settings in the OpenSpirit Desktop
preferences.

Clicking the Set Column Order icon in the attribute selection window tool bar opens a
window that can be used to change the left to right ordering of the columns that have
been selected for display. Select one or more attributes and click the up or down
arrow icon to change the column order. The attribute at the top of the ordering window
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shown at the left-most column position in the data type view tab. The attribute at the
bottom of the ordering window shown at the right-most column position.

Clicking the Reset icon in the attribute selection window tool bar restores the attribute
display order and display on/off settings to their default values. The defaults are
determined by the model view or data model selected from the data source selection
window. Any changes to the attribute description or display format are not reverted.

Sending Data Selection Events
The primary use of the OpenSpirit Data Selector, in addition to browsing data sources, is to
send a selection of one or more data items to another application. This is accomplished
using data selection events or drag and drop. Data selection events are sent by selecting
one or more rows in the currently selected data type view and clicking the data selection
event send button in the data type view's tool bar. This sends the identity of all
selected rows to any application that you are running that is listening for OpenSpirit data
selection events.
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Note: Each application that is listening for data selection events react to the
event in a way appropriate for that application. Each application determines
which data type it listens for and what it does when the event is received. Many
applications that listen for OpenSpirit data selection events only listen for
selections of data types that are defined in the OpenSpirit common model.
Selection events for native model data types such as OpenWorks or Studio
native model types are ignored by applications that only listen for selection of
OpenSpirit common model data types.

The identity of a row in a data type view is represented by an OpenSpirit data key.

Removing Received Data Selection
Data rows originating from a received data selection event are displayed with a lightning
bolt icon in the left-most column. These rows can be removed from the data type view

by selecting them and clicking the Remove Received Data Selections icon in the data

type view tool bar. The remove icon does not remove rows that were not received from a
data selection event.
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Drag & Drop
Selected rows can be dragged from the Data Selector and dropped on other applications
that have been enabled as an OpenSpirit drag and drop target. OpenSpirit viewers and
many third-party applications can respond to data selection drop events that were initiated
from the Data Selector. Dragging data selections is done by selecting one or more rows in
the Data Selector, press and hold the left mouse button while moving the mouse to the
application you wish to drop them on. Release the mouse button to complete the drag and
drop operation.

Each drop target application responds in its own way to drops. Most applications respond
to drops the same way that they respond to data selection events. The difference between
sending a data selection event and performing a drag and drop is data selection events
sent to all listening applications, whereas drag and drop only affect the application that
the drop is performed on.

Copy to Clipboard
Selected rows can be copied from the Data Selector to your computer's clipboard to make
them available for pasting into other application such as Microsoft Excel or Microsoft Word.
Selected rows can be copied by pressing and holding the Ctrl key while pressing the C
key. Rows can also be copied by pressing the right mouse button over the selected rows to
display the right mouse button pop-up menu. Select the Copy option in the pop-up menu
to copy the selected rows to the clipboard. The column header and all columns of the
selected rows are copied. Turn off display of any columns that you do not wish to copy.
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Rows can also be copied from Data Selector array details pop-up windows using Ctrl+C or
the right mouse button pop-up menu.
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Data Source Selection
This section of Data Source Selection covers the following topic:

Data Source Selection Window
The Data Source Selection window is used to select the sources of data that queried by the
Data Selector. The Data Source Selection window opens automatically when activating the
Data Selector tool. It can also be opened by clicking the Select Data Sources icon in the
Data Selector tool bar.
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Data source and project selection tree

The Data Source Selection window displays a list of all the OpenSpirit data sources that
have been configured in your OpenSpirit installation. Data sources that partition data by
project can be expanded to display their available projects by clicking the right facing
arrow that is located to the left of each data source containing projects.
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Click the checkbox next to the data sources and/or projects that you wish to browse in the
Data Selector and press the Ok button. The Data Selector appears in the OpenSpirit
Desktop.

The checkbox next to data sources that contain projects has three selection states. The
unchecked state indicates that none of the data source's projects are selected. The
partially checked state indicates that at least one, but not all of the projects in the data
source are selected. The checked state indicates that all of the data source's projects
are selected.

Tip: Some data sources (for example, OpenWorks, and Studio) show projects
that the account used to run the OpenSpirit data connector has permission to
access. This means the Host/Account settings of the data source may determine
the projects that appear under the data source.
Significant computer resources may be required to access each selected project.
Try to minimize the number of projects you select.

Settings Column

The Settings column displays icons that indicate the status of the credential settings for
each data source. See the Settings Icons section of this help guide for an explanation of
the icons that appear in the Settings column.
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Host/Account Column

The Host/Account column displays the host computer and the operating system account
that used to run data server processes for each data source. See the Host/Account section
of this help guide for an explanation of the host/account setting.

Tool bar

The Data Source Selection window provides a tool bar containing buttons used to manage
data source selections and settings. The tool bar buttons are described below.

Set host and account button
Select one or more data sources in the data source tree and press the Set host and
account button to open a window that can be used to set the host machine and operating
system account that should be used to run the data server processes needed to access the
selected data sources. The selected data sources must be supported to run on a common
operating system platform.

This opens the Set Server Activation window for the data source.
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Clear the Use Default checkbox to enable selecting a specific host/account to use when
accessing the data source. Select the Use Default checkbox to use the host and account
that has been set as the platform default.

Host Selection

The host selection list contains a list of all host computers that are registered with your
OpenSpirit installation and have an operating system type supported by the data source.
The list may include hosts listed in the Satellites tab and the Visibility tab of the Install
Config Manager tool for your OpenSpirit master installation. The list may include hosts you
have selected as a platform default or as the host for other data sources.

The host selection list may have a choice that appears as <Enter New Host>. The presence
of the new host option in the host selection list is determined by the Host Discovery
Enabled option of your master installation. See the Advanced Master Settings section of
the Install Config Manager tool help guide for more information about this option.
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The new host choice enables you to type in the name of a host that is not currently known
to your OpenSpirit installation. Host names that cannot be resolved with your domain
naming service (DNS) is not allowed.

Tip: No check is made that the entered host name is a platform type that is
supported by the data source. Platform incompatibility is not detected until a
request is made to start a new data server process on that host.

Tip: You can enter localhost as the host name for data sources that can run on
Windows and on Linux in order to force the data server process to run on your
Windows desktop.

Otherwise the data server process is started on your default Linux host.

Account Selection

The account selection list contains the name of your OpenSpirit primary account, your
OpenSpirit secondary account if you have one set, and any additional accounts you may
have added using the Host Account Settings tab of the User Setup Wizard. Use the User
Setup Wizard to add accounts to the account selection list.

Clear all selected button
The Clear all selected button de-selects all data sources and projects that are selected in
the data source and project selection tree.

Platform Defaults button
The Platform defaults button opens a window used to set the default host and account to
use for each operating system platform that you have a master or satellite installed on.

The following image shows the platform defaults window for an OpenSpirit master that has
installations on Linux and Windows. The appearance of the platform defaults window may
differ from what is shown below depending on the remote startup method configured in
your OpenSpirit master installation. See the help guide for the Host Account Settings tab of
the User Setup Wizard for details of setting the platform defaults.
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Manage Passwords button

The Manage Passwords button opens a window that can be used to set the account
passwords used for the operating system accounts used to run data server processes. The
appearance of this window may differ from that shown below depending on the remote
startup method configured in your OpenSpirit master installation. See the help guide for
the Host Account Settings tab of the User Setup Wizard for details of setting account
passwords.

Get from session button

The Get from session button allows you to select the data sources and projects from
sessions that have been created with the OpenSpirit Session Manager tool. Clicking the
button opens a window that allows you to select a session. The data sources and projects
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listed in the selected session selected in the Data Source Selection Window's data source
and project selection tree.

Selecting Data Sources and Projects
The Data Source Selection window is used to select the sources of data that queried by the
Data Selector. The Data Source Selection window opens automatically when activating the
Data Selector tool. It can also be opened by clicking the Select Data Sources icon in the
Data Selector tool bar.
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Data source and project selection tree

The Data Source Selection window displays a list of all the OpenSpirit data sources that
have been configured in your OpenSpirit installation. Data sources that partition data by
project can be expanded to display their available projects by clicking the right facing
arrow that is located to the left of each data source containing projects.
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Click the checkbox next to the data sources and/or projects that you wish to browse in the
Data Selector and press the Ok button. The Data Selector then appear in the OpenSpirit
Desktop.

The checkbox next to data sources that contain projects has three selection states. The
unchecked state indicates that none of the data source's projects are selected. The
partially checked state indicates that at least one, but not all of the projects in the data
source are selected. The checked state indicates that all of the data source's projects
are selected.

Tip: Some data sources (for example, OpenWorks) only show projects that the
account used to run the OpenSpirit data connector has permission to access.
This means the Host/Account settings of the data source may determine the
projects that appear under the data source.
Significant computer resources may be required to access each selected project.
Try to minimize the number of projects you select.

Data Source Settings
The Settings column to the right of the data source project selection tree is used to
manage credentials that are needed to access some OpenSpirit data sources. Some
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credentials are optional and some are mandatory. Some OpenSpirit data source does not
have any credentials.

Settings Icons

The Settings column displays icons that indicate the status of the credential settings for
each data source.

A blue recycle icon is shown next to data sources when the presence of credentials has

not yet been determined. Credentials are not examined until you select a data source or
project in order to speed up the display of the Data Source Selection window. You can also
force a credentials check for a data source by clicking the recycle icon.

A green check mark icon next to a data source indicates that all mandatory credentials

needed to access the data source have been entered. Data sources with optional
credentials, or with mandatory credentials that have default values supplied when
configuring the data source are also shown with a green check mark icon. Click the green
check mark icon to display the settings window used to view and manage the credentials
for a data source.

A red horizontal bar icon is shown next to data sources that have one or more

mandatory credentials that have not been entered. The missing credentials must be
entered before accessing these data sources. Click the red horizontal bar icon to display
the settings window used to enter the missing mandatory credentials.

Settings Windows

The Windows that appears when you click a settings icon are used to enter required and
optional credentials that are used when connecting to a data source. The content of the
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window depends on the type of the data source (for example, OpenWorks, Studio,
Kingdom). Following is an example of a credentials window. See the Data Source Details
section of the Data Source Configuration Tool Help guide for information about each of the
data source type specific credentials Windows.

Enter the missing credentials required by the data source and press the Ok button.

Data sources that require credentials at the project level lists all accessible projects in their
credentials window. The same credential values can be entered for multiple projects by
selecting the projects you wish to assign a credential value to and pressing the Set for
Selected icon in the credential window tool bar. This opens a window that can be used

to enter credential values that applied to all selected projects.

Pressing the Clear credentials for selected rows icon in the credential window tool

bar removes all credentials previously entered for all selected projects.
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Host, Account, & Password Settings
The host computer and account used to run OpenSpirit data connectors is determined by
your Host/Account settings which is managed using the Data Source Selection window.

Platform Defaults

Data connectors will run on the host and account that has been set as your default. Your
default host account is set by clicking on the Platform Defaults icon in the Data Source

Selection window tool bar. This opens the Platform Defaults window that is used to enter
the host and account you want to use as your default to run OpenSpirit data connectors on
for each operating system platform that is supported by the data sources that are
configured in your OpenSpirit installation.
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Enter the host name and select the account you would like to use for your default. Type a
host name directly in the Host column if the host you would like to use is not in the host
drop-down selection list.

Tip: Use the Host Account Settings tab on the User Setup Wizard tool to add a
new account to the account drop-down list if the account you would like to use
is not in the list.

Manage Passwords

Click on the Manage Passwords icon in the Data Source Selection window to open the

Manage Passwords window. This window can be used to update your account password if
it has changed. Type in the new password and press the Ok button.

Host and accounts can be set on individual data sources by clicking on the <Default>
hyperlink next to the data source.
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This will open the Set Server Activation window for the data source. Un-check the Use
Default option to enable selecting a specific host/account to use when accessing the data
source.

A specific host/account can be set on multiple data sources by selecting multiple data
sources in the Data Source Selection window and pressing the Set host and account for
selected icon in the Data Source Selection window tool bar. This will open the Set

Server Activation window for setting the host/account for the selected data sources. The
selected data sources must be supported to run on a common operating system platform.

Selecting a Model View
The Data Source Selection window can be used to select the data model or model view to
be used by the Data Selector to display data. The data model or model view is selected
using the Select Model View dropdown list at the bottom of the Data Source Selection
dialog.



TIBCO OpenSpirit® Runtime User Guide

135 | Data Source Selection

The dropdown list contains all data models and model views that are valid to use with the
selected data sources. All data models and model views are shown in the model view
selection list if no data sources have been selected.

The selection list interacts with the data source display above it. Selecting data sources
causes model views and data models to be removed from the model view selection list.
Selecting a model view or data model in the data model selection list may remove data
sources that cannot be viewed using the selected model view or data model. This
interaction prevents selecting a combination of data source and model view that are
incompatible. Any data source can be viewed using the OpenSpirit data model and model
views. Data store specific model views and data models can only be used to view data
sources of the same type.
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Process Manager Overview
The OpenSpirit framework provides access to multiple versions of a variety of geoscience
data repositories. Each type of geoscience database has its own computing platform
requirements that often change from one release version to the next. The computing
platform required to access a particular data repository may differ from the computing
platform used to run your application. The OpenSpirit framework enables these
heterogeneous computing platforms to be bridged making it possible for your application
to work with data that otherwise would not be accessible. This platform bridging requires
the OpenSpirit framework to create processes on other computers in your company's
network in order to work with data that is not accessible from your desktop computer.

Two types of processes are created by the OpenSpirit framework. They are data connector
processes and process starter processes. These processes are created on demand when an
OpenSpirit tool or an OpenSpirit enabled application needs to access a data repository.
The processes run in the background with no user interface and end after some
configurable period of inactivity. The Process Manager tool is used to monitor and control
these background processes that are created by the OpenSpirit framework.

The Process Manager tool is accessed from the OpenSpirit Desktop by clicking the Process
Manager tool bar icon or by choosing the Tools > Data Browser > Process Manager
menu item. The Process Manager displays all of the background processes started by the
OpenSpirit framework that is running. The Process Manager shows the processes that were
created for the user that is running the OpenSpirit Desktop. The OpenSpirit Desktop shows
processes that have been created for all OpenSpirit users when it is running from the
OpenSpirit Runtime administrator account or if the desktop has been put in admin mode
using the admin mode button in the desktop tool bar. The OpenSpirit shared service
process is also shown when running in admin mode.
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The process list displayed by the Process Manager is not automatically refreshed. A refresh
button is provided to force the Process Manager to update the process list to display
the currently running processes.

The Name column in the process table displays the name given to the process by the
OpenSpirit framework. Data connector process names include the name of the data source
that it is connected to. Some data connector process names also include the name of a
project if the data source does not permit a process to access multiple projects. Process
starter processes all have the name Process Starter. The OpenSpirit shared services process
appears with the name Shared Service.

The Host Name column shows the name of the computer that the process is running on. It
may appear as an IP address during the PENDING stage of process startup.

The Username column shows the OpenSpirit username of the user that caused the process
to start. This may or may not be the same as their computer login account name.

The Account Name column shows the computer login account being used to run the
process. This is most often the OpenSpirit user's login account name, but may differ if a
different account was used when configuring data source host and accounts using the
OpenSpirit User Setup wizard.

The Log file path column shows the fully qualified name of the log file that the process is
writing its log messages to. The log file path may not be directly accessible from the
computer that your OpenSpirit desktop is running on. The log file path is a click able
hyper- link. Clicking the path opens a window that displays the log file content and
provides a button that can be used to save the log file in a folder of your choice.

The Start Time column shows the date and time that the process started.

The Process ID column shows the operating system process id of the process. This can be
useful if you need to identify the process in the Microsoft Windows Task Manager or are
using the UNIX ps or top command to monitor the process.

The Account Domain column displays the domain that the process account is defined in.
Currently all accounts appear in Global Domain.

The State column provides an indication of the state of the process as it is starting. A
process appears with a PENDING state between the time that it was requested to start and
the time it has completed its startup initialization. Processes appear with an ACTIVE state
once they are fully initialized and ready to respond to requests.

The Type column categorizes the processes. Data connector processes appear with type
Data. Process starter processes appear with type User. The shared service process appears
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with type Shared. The type column is primarily provided to enable them to be grouped
according to type by clicking the column header to sort by type.

The Dedicated To column is usually empty. The OpenSpirit framework provides the ability
for an application to request a data connector that is dedicated for its use rather than
sharing the data connector with other running applications. You may see something in this
column when running the OpenSpirit Copy Manager to copy data into an OpenWorks or
Studio data source. The value that appears the name of the copy job.
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Inactive Process List
The bottom section of the Process Manager shows previously run processes and processes
that failed to start due to some error condition. Processes with start errors appear with red
text and a message in the Error Message column. Previously run processes that did not
experience a startup error appear with black text and no value in the Error Message
column.

Process start attempts by the OpenSpirit framework sometimes fail. The most common
causes of failure are license checkout failure or invalid host, account, or password
information entered into the User Setup wizard. Other common causes of failure are a
database outage, invalid information entered into the Data Source Configuration tool, or a
network outage.

Note: The process startup failure messages are maintained by the OpenSpirit
framework for a period and then are purged from the system. The default time
period before purge is determined by the Error Expiration Time setting on the
OpenSpirit master installation advanced settings panel.
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Tip: Select a startup failure message, press the right mouse button, and choose
the Copy option to copy all of the selected startup error information to the
system clipboard. The error information can then be pasted into an email
message or document in order to preserve it before it is purged. The message
information is useful if the startup failure requires assistance from OpenSpirit
support to resolve.

The information columns in the inactive process list are different from the columns in the
active process list.

The Name column in the startup error list displays the same name that would appear in
the active process list had the process successfully started. See the name column
description in the previous section of this help guide.

The Type column in the startup error list also displays the same type that would appear in
the active process list had the process successfully started. See the type column
description in the previous section of this help guide.

The Log file path column shows the fully qualified name of the log file that the process
wrote its log messages to. The log file path may not be directly accessible from the
computer that your OpenSpirit desktop is running on. The log file path is a click able
hyper-link. Clicking the path opens a window that displays the log file content if the file is
on a local file system or if a process starter is still running on the host that the process ran
on. The log file can also be displayed if the OpenSpirit shared services process has access
to the log file.

The Shutdown Time column shows the date and time that the process stopped or failed
to start.

The Error Message column shows a message that describes the cause of the startup
failure. The value is blank if the process did not experience a startup failure.

The Error Details column contains a Detail... hyper link if the process experienced a
startup failure. The value is blank if the process did not experience a startup failure. Click
the hyper link to open a window that displays all of the startup error details.
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Process Manager Tool Bar
The Process Manager tool bar contains buttons used to monitor and control the active
processes. These actions are described below. The tool bar resides in the upper right-hand
corner of the Process Manager window.

Refresh Button

The refresh tool bar button refreshes the process list by looking for newly started
processes and by removing any processes that are no longer running. The process list is
automatically refreshed when returning to the Process Manager tool after using a different
tool in the OpenSpirit Desktop.

Stop Process Button

The stop process button is enabled when one or more active processes are selected.
Clicking the stop button displays a confirmation window. Answering Yes to the
confirmation stops all selected processes. Answering No to the confirmation leaves the
selected processes running.

Display Information Button

The display information button is enabled when a single active process is selected.
Clicking the information button opens a window that displays information about the
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selected process. The type of information that is displayed varies according to the process
type. Data connector processes display the most information of all the process type. Data
connector process information includes the OpenSpirit licenses the process has checked
out, the process' inactivity time-out, process memory usage, the amount of time the
process has been inactive, the processes log message level, the location and name of its
log file, and a list of active connections to the data connector. Process starter processes do
not display license information or active connection information.

View or Edit Settings Button

The view or edit settings button is enabled when a single active process is selected.
Clicking the settings button opens a window that displays the process settings that can be
modified to control some aspects of the process' behavior. The settings that can be
controlled are the process inactivity time-out and the process message log level. The
settings window also contains a Dump Stack Traces button. Clicking this button causes
thread call stacks to be printed to the process' log file. The call stack information can
sometimes be useful to OpenSpirit support personnel when investigating a problem.

Process Time Out

Process starter and data connector processes will shut themselves down after a period of
inactivity. Process starter inactivity is measured based on the amount of time that has
elapsed since it was last requested to start a process. Data connector inactivity is
measured based on the amount of time that has elapsed since an application used the
data connector to connect to its data source. The process inactivity timer does not start
until all applications have disconnected from the data connector process.

Tip: Some applications may remain connected even though they are not making
any data read or write requests. There is a separate activity time-out that is used
to forcibly close unused but open application connections. This time out is
referred to as a connection time-out. The default connection time out is 8 hours.
The default time out is rather large to prevent the OpenSpirit framework from
forcibly closing an application connection and possibly causing loss of work
when the application user may have merely gone to lunch or to a long meeting.
Applications are free to override the 8-hour default when making their
connections to a data source.
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The default process starter time-out and the default data connector time-out are
determined by the OpenSpirit master installation's advanced settings. Speak to your local
OpenSpirit administrator if you feel the default time is too short or too long.

Log Levels

The log level determines the amount of information that is written to the process' log
message file. The WARN level is the default for most process types. The meaning of each
log level is described in the following table.

Log
Level

Description

ERROR Produces the least amount of log file output. This level should only be used if
you have no interest in anything but failures.

WARN Produces less output than INFO. Consider using this level if you are trying to
keep the log file size down and are not interested in details of successful
operations. Only failure information is reported. Messages about data that
could not be copied or scanned are produced, but messages about
successful a successful copy or scan are not produced.

INFO The default level. This is the recommended log level. It produces a
reasonably detailed amount of information about the job execution.
Messages about the number of each data type copied or scanned is
produced using this log level.

DEBUG Produces a large amount of output. You typically should not use this level
unless instructed by OpenSpirit support. Large numbers of program
execution messages needed to diagnose problems are produced when this
log level is used.

ALL Produces a tremendous amount of output. This level should never be used
unless instructed by OpenSpirit support. Volumes of very detailed program
execution messages needed to diagnose difficult problems are produced
when using this log level. This log level may produce multi-gigabyte log files.
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Help Button

The help tool bar button is always enabled. Clicking the help button opens this help
guide.
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Sessions
A Session is simply a set of data source selections, a model view preference, a coordinate
system preference, and a set unit of measure preferences that has been given a name.

Sessions are most commonly used with the OpenSpirit Data Selector or with third-party
OpenSpirit enabled applications that make use of OpenSpirit sessions. Sessions are stored
in the OpenSpirit master installation's database. The Using Sessions section of this help
guide describes some of the ways that sessions can be used in the OpenSpirit Desktop.

Tip: Earlier versions of the OpenSpirit framework required sessions to be created
for many work flows. Session creation and use are now optional in OpenSpirit
tools and applications. There may still be third-party applications that require
sessions to be created when connecting to the OpenSpirit framework.

Session Visibility

Sessions can be public or private. Public sessions are visible to all OpenSpirit users. Private
sessions are only visible to the user that created them. OpenSpirit administrator privileges
are required to create, modify, or delete public sessions. Public sessions provide a way for
a collection of sessions to be created and shared with all OpenSpirit users.

Session Name Uniqueness

Public sessions must have unique names. A user's private sessions must have unique
names. Private sessions may be given the same name as a public session. Private sessions
may also have the same name as another user's private session. A user's private session
that has a name that is identical to the name of a public session hides the public session
from that user. Deleting a private session that has a name that matches a public session's
name makes the public session visible to the user again.
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Session Manager Overview
The Session Manager Tool is accessed from the OpenSpirit Desktop by clicking the Session
Manager tool bar icon or by choosing the Tools > Data Browser > Session Manager
menu item. The Session Manager tool is used to inspect, create, delete, and modify
sessions.

The table in the top portion of the Session Manager window lists all public sessions
together with all private sessions created by the user. The Session Manager also provides a
tool bar with buttons used to create, view, modify, and delete sessions displayed in the
table. The bottom portion of the Session Manger window is used when creating, viewing, or
modifying a session.

The Visibility column in the session table indicates the public or private visibility of each
session. Public sessions that are hidden by a private session having the same session name
are not visible in the session table.

The Name column shows the name that was given to each session when it was created.
Session names cannot be changed. Session names must consist of alphanumeric
characters and the underscore character. Spaces are not permitted in session names.

The Description column shows a textual description of a session. The description is
optional and may contain any information that the session creator feels is appropriate.

The Created column shows the date and time that the session was first created.

The Last Modified column shows the date and time that any change was made to the
session.
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Session Manager Tool Bar
The Session Manager tool bar contains buttons used to create, edit, copy, and delete
sessions. These actions are described in the following sections of this help guide. The tool
bar resides in the upper right-hand corner of the Session Manager window.

Refresh Button

The refresh tool bar button refreshes the session list by re-reading the information
from the OpenSpirit master installation's database.

Save Session Button

The save session tool bar button saves a newly created session or save modifications
made to an existing session.

Create New Session Button

The create session tool bar button opens the session editor wizard in the bottom
section of the session manager window enabling the new session information to be
entered. See the Creating New Sessions section of this help guide for information about
use of the session editor wizard to create sessions.
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Edit Session Button

The edit session tool bar button is enabled when a session is selected in the session
list. Clicking this button opens the selected session in the session editor wizard to make it
available for viewing or editing.

Copy Session Button

The copy session tool bar button is enabled when a session is selected in the session
list. Clicking this button opens a prompt for the name to use for the new session copy. The
new copy appears in the list of sessions. The copy can then be selected and modified by
clicking the edit session button.

Delete Session Button

The delete session tool bar button is enabled when one or more sessions are selected
in the session list. Clicking the delete button displays a confirmation message. All selected
sessions are deleted when the confirmation window's Ok button is pressed. Deletions
cannot be undone.

Tip: The delete button is not enabled if any public session is selected and the
OpenSpirit Desktop is not in admin mode. Public sessions can only be deleted
when the OpenSpirit Desktop is in admin mode.

Help Button

The help tool bar button is always enabled. Clicking the help button opens this help
guide.
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Creating New Sessions
New sessions are created by clicking the Create a new session icon in the Session
Manager tool bar. This opens the session editor wizard in the lower portion of the Session
Manager window. Enter the name, a description, and select one or more data sources. The
session name is required, but the description and data source selection is optional.

Tip: A session with no data source selection can be a convenient way to create a
named coordinate system and unit preference without binding it to a specific
data source selection.

The session's visibility is indicated to the right of the session name entry field. Private
visibility means that the session can only be seen by the user that created it. Public
visibility means that the session can be seen by all users except for users with a private
session having the same name as the public session. The session is created with public
visibility if the OpenSpirit Desktop is in admin mode. OpenSpirit Desktop is in admin mode
when running the on the OpenSpirit administrator account. OpenSpirit Desktop can also be
put into admin mode using the admin mode toggle in the desktop tool bar.
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Press the button in the lower right corner of the session editor wizard to advance

to the Units and Coordinates panel.

The data sources that were selected on the previous wizard panel appear in a list at the
top of the Units and Coordinates panel. The session's coordinate reference system can be
selected from one of these data sources, or it can be selected from the list of predefined

EPSG coordinate reference systems by clicking the button. See the
Coordinate System Preferences section of the OpenSpirit Desktop Help guide for
information about using the EPSG coordinate system selection window.

A window will appear after the session coordinate system is selected that asks if you want
to use the coordinate system for the session's unit preferences. Answering yes causes the
unit preferences to be set to the units found in the selected coordinate system.
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The last step to creating the session is to select the unit preferences and then press the
save button in the Session Manager tool bar to create the session. The new session
appears in the session list when the save is performed.
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Viewing and Editing Sessions
A session's description, model view, data source selections, coordinate system preference,
and units preference can be viewed and modified by opening the session in the session
editor wizard. Open a session in the session editor wizard by selecting it in the session
table and pressing the edit session button in the Session Manager tool bar. Sessions
can also be opened by double-clicking the session in the session table.

Tip: The edit session button is not enabled when a public session is selected
and the OpenSpirit Desktop is not in admin mode. However, double-clicking a
public session opens it in the session editor wizard. Any changes made to the
public session when not in admin mode causes a private session with the same
name to be created. The new private session hides the public session for that
user. Deleting the private session restores visibility of the public session that it
was created from.

Note: Changes can be made to a session that was opened in order to view it,
not to modify it. Take care not to press the save button if unwanted changes are
accidently made to a session while viewing it in the session editor wizard.

Press the save button once all desired modifications have been made to the session.
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Using Sessions
Sessions can be used in a variety of ways in the OpenSpirit Desktop and in other
OpenSpirit enabled applications. This section of the help guide describes a few of the ways
sessions can be used.

In the Data Selector
The most common use of sessions is to establish a coordinate system preference, a unit
preference, and a data source selection preference that can be easily selected when using
the OpenSpirit Data Selector. Any combination of these preferences can be assigned to a
session, which can then be selected when the Data Selector's Data Source Selection
window appears.

Clicking the session selection button in the Data Source Selection window's tool bar
opens a session selection window that can be used to select a session.
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Select one of the sessions and press the Ok button. The selected session's data source
selections, coordinate system preference, and unit preference used by the Data Selector.
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Desktop Coordinate System Preferences
Sessions can also be used to select the OpenSpirit Desktop's coordinate system preference.
Click the Select from OpenSpirit Session... button to select the desktop coordinate and
unit preferences from a session.
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Administration Tools
This section of Administration Tools covers the following topic:

Data Source Configuration
In order for OpenSpirit to access data in the various vendor data sources, you must tell
OpenSpirit about each source, which is known as configuring the data sources. With the
introduction of Satellite installations and Windows based data sources, the task of
configuring all of the possible combinations of data sources is quite complex. In this
section we describe the configuration of all supported data sources and the strategy
required to properly configure data sources on satellite installations. The tool used by
OpenSpirit administrators to setup and configure supported data sources is the Data
Source Configuration Tool, which is available in the OpenSpirit Desktop.

The Data Source Configuration Tool is the primary means of configuring vendor data
sources in OpenSpirit on Linux and Windows. The information does vary between data
sources but in general it consists of:

l The name of the configuration. This is a free-form unique name given by you.

l Vendor data source installs directory locations. This is used to access vendor
libraries and functions.

l Database information relating to the data sources. This is used to access project
data in the vendor’s data sources.

l Vendor license information pertaining to the data sources. Which is needed in
order to check out a vendor data source license.

The configured vendor data sources contain project data that users can access using tools
and applications developed with the OpenSpirit framework. The supported vendor data
sources that can be configured in OpenSpirit are listed in the Data Source Details section
of this guide.

A command line data source configuration utility is also available. The command-line utility
is described in the Command-Line Configuration Utility section of this guide.
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Data Source Configuration Overview
This section of Data Source Configuration Overview covers the following topic:

Getting Started
The Data Source Configuration tool is accessed from the OpenSpirit Desktop by clicking the
Data Source Configuration tool bar icon or by choosing the Tools > Administrator >
Data Source Configuration menu item.

The Data Source Configuration tool is platform aware, and configures data sources that run
on the platform’s operating system that the tool was started from. The supported
platforms for each data source type are listed in the Data Source Details section of this
guide.

Some data source types can be configured as private data sources. Private data sources
are only visible to the user that configures a private data source. Public data sources are
visible to all OpenSpirit users. Be logged in as the OpenSpirit administrator in order to
create, edit, or delete public data source configurations.

Tip: Private data sources are supported by data sources that store data on local
PC drives. For example, Kingdom or Petra projects that are stored on a local PC
drive and are only accessible to a single Windows account.

The Data Source Configuration tool opens in read-only mode when it is run using an
account that does not have the Administer OpenSpirit Runtime user right. This gives
users the ability to view the various data source configurations. In this mode you can also
configure private Windows based data sources, for example Kingdom projects you have
local on your Window’s C drive.

Data Source Configuration Tool Layout

The tool’s interface is divided into two sections: the Data Sources Panel on the left-hand
side and the data source Attribute Panel on the right-hand side.
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The Data Sources Panel presents a tree of data sources organized by data source type and
version. Configured public data sources appear in the tree with a cylinder icon next to
the data source name. Configured private data sources appear in the tree using a cylinder
icon containing a person .

Tip: Data connectors that have been disabled using the OpenSpirit Install Config
Manager not appear in the Data Sources tree.

Selecting a configured data source in the tree results in display of an Attribute Panel on the
right-hand side of the Data Source Configuration tool. The data source's attributes can
then be viewed. The attributes may also be edited if you have permissions to administer
the selected data source.
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Creating New Data Sources

New data sources are added to the tree by selecting the data source type and version node
in the tree and clicking the create data source icon in the tool bar or selecting the
create option in the right mouse button popup menu. This displays the New Data Source
dialog where you enter the name to be given to the new data source, an optional
description of the data source. Note, the data source description cannot be changed once
the data source has been created. Use the data source copy feature to change the
description.

A public data source is created if the Data Source Configuration tool is running in admin
mode. A private data source is created if the Data Source Configuration tool is not running
in admin mode. Running the OpenSpirit Desktop using the OpenSpirit administrator
account (that is, the account used to install the OpenSpirit master installation)
automatically runs the tool in admin mode. Admin mode is not enabled by default when
running the OpenSpirit Desktop using any other account. Admin mode can be toggled on
and off using the Tools > Administrator > Toggle Admin Mode menu option if you know
the OpenSpirit administrator password or if your OpenSpirit account has been granted the
Administer OpenSpirit Runtime right.

An Attribute Panel is then displayed on the right-hand side of the Data Source
Configuration tool. Enter all the required information and click the save icon in the tool
bar. The information that is required varies by type and version of the data source.

Data sources can be copied by selecting a data source in the tree and clicking the copy
icon in the tool bar or selecting the copy option in the right mouse button popup
window.

Data sources can be renamed by selecting a data source in the tree and clicking the
rename icon in the tool bar or selecting the copy option in the right mouse button
popup window.
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Data sources are deleted by selecting a data source in the tree and clicking the delete icon
in the tool bar or selecting the delete option in the right mouse button popup menu.

When you delete a data source, a confirmation dialog opens that lists the sessions that
include this data source. Proceeding with the deletion removes the deleted data source
from all associated sessions.

Note: Keep in mind that the data source may also be referenced by OpenSpirit
Copy Manager jobs, Scan Utility jobs, and by data keys saved in scan data sets
and application projects, such as Petrel projects.

Unsaved attribute value edits can be restored to the currently saved state by pressing the
refresh icon in the tool bar.

Data Source Configuration Tool Bar
The Data Source Configuration tool bar contains buttons used to refresh, save, create,
copy, rename, and delete data source configurations. These button actions are described
below.

The tool bar resides in the upper right-hand corner of the Data Source Configuration
window.

Refresh Button

The refresh button refreshes the content of the data source tree that resides along the
left side of the data source configuration tool and it refreshes the configuration settings of
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the currently selected data source. A save prompt appears if there are any unsaved
changes in the currently selected data source configuration.

Save Button

The save button is enabled when a change is made to a data source configuration
setting. Clicking the button saves the changes to the OpenSpirit metadata repository.

Create Button

The create button is enabled when a data source type is selected in the data source
tree that can be configured on the operating system platform that the OpenSpirit Desktop
is running on. See the Creating New Data Sources section for information about creating
data source configurations.

Copy Button

The copy button is enabled when a data source is selected in the data source tree that
can be configured on the operating system platform that the OpenSpirit Desktop is running
on. Clicking the copy button opens a prompt for the name to give the new copy.

Rename Button

The rename button is enabled when a data source is selected in the data source tree
that can be configured on the operating system platform that the OpenSpirit Desktop is
running on. Clicking the rename button opens a prompt for the new name to give to the
data source.

Note: A data source may be referenced by OpenSpirit Copy Manager jobs, Scan
Utility jobs, sessions, and by data keys saved in scan data sets and application
projects, such as Petrel projects. Renaming a data source invalidates any items
that refer to it.

Delete Button

The delete button is enabled when a data source is selected in the data source tree.
Clicking the delete button opens a confirmation prompt.
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Note: Any credentials and server activation preferences entered by users also be
removed when deleting a data source. Also, the data source may be referenced
by OpenSpirit Copy Manager jobs, Scan Utility jobs, sessions, and by data keys
saved in scan data sets and application projects, such as Petrel projects.
Deleting a data source invalidates any items that refer to it.

Help Button

The help button opens this help guide.

Common Configuration Settings
The process of configuring a data source may seem overly complex, therefore you should
take time to gather the information needed for each data source that you are configuring.

The Data Source Configuration Tool attempts to automatically gather and validate as many
configuration values as it can. It does this by interrogating the data source’s (that is,
OpenWorks, and Kingdom) setup files after you have entered the configuration name and
the install directory location for the data source. During the configuration of different data
sources the configuration tool provides feedback information and hints in the form of
helper icons.

Each data source type requires a different set of configuration information. However, many
of the settings are for similar types of information. A standard set of data entry fields and
icons are used in the configuration panels for all of the data source types. The helper icons
and their descriptions are as follows:

File Selector : pressing this icon opens a file select dialog, which is used to set
directory locations and pick file location. Ex. Selecting the Openworks install
directory.

Verification Indicator: this icon indicates that the Configuration Tool was able to
verify the input value. This verification can be related to:

l File or directory location

l Project data source Oracle connection information is correct
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l OpenSpirit query account is accessible via account name/password

Non-Verification Indicator: this icon indicates that the Configuration Tool could not
verify the input value. Also, the background color of the value input colored light
red as a further indication. Pressing this icon opens an information dialog that
informs you of the reasons that the value could not be verified.

NOTE: The Tool attempts to verify all entries, but in some environments (even when
the values are known to be correct) the verification could fail. Therefore, you have
the ability to save the configuration even with non-verified values.

Dropdown Selector: when pressed, this icon presents you with a list of values to
select from. The values in the list are determined by the configuration parameter
that you are selecting. They are:

1. If you are selecting a directory/file location the list is populated with all the
previously selected locations.

2. If you are selecting an Oracle parameter (that is, OWSYSSID and TWO_TASK),
then the list is populated with all the Oracle

Instances found after parsing the tnsnames.ora file.

Builder: pressing this icon brings up dialogs to help you configure the following:

1. URL Builder: this Builder is associated with the DB URL value. The Builder
creates a URL to facilitate connection to the project data source’s
(OpenWorks, Studio, and so on) Oracle or SQL Server database. This URL
tells OpenSpirit where to find the project databases it needs to access.

2. Query Account Builder: this Builder is associated with the Query Account
values. The Builder is used to create a database account in the project data
source’s database. This query account is typically used by OpenSpirit to
access the names of available projects.

Add a row (Project Catalog builder only)

Delete arow(ProjectCatalogbuilderonly)
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Database URL Builder

The database URL dialog is used to enter information used to connect to an Oracle or SQL
Server database.

Name Description Hints & Finding Values

Provider The type of database provider, Oracle,
or SQL Server.

Ask your database
administrator.

Oracle Provider

SID/ServiceName Choose to use an Oracle SID or an
Oracle service name. Enter the SID or
Service Name of the data source's
Oracle instance.

The SID and service
names can be found in
your tnsname.ora file.

Host The host name of the computer Located in the
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Name Description Hints & Finding Values

running the data source's Oracle
instance.

tnsname.ora file. This
can either be the
machine name or its IP
address.

Port The Oracle listener port number. The listener port can be
found in your
tnsname.ora file. The
default Oracle port
number is 1521.

Custom DB URL Select the Custom Editor option to
enter custom database URLs such as
URLs needed to support Oracle RAC.
The Custom DB URL field is enabled by
selecting the Custom Editor option.

Use of the custom field
requires expertise in
JDBC URL syntax. Only
used this field when
instructed by OpenSpirit
support.

SQL Server Provider

Host The host name of the computer running
the data source's SQL Server instance.

Ask your local database
administrator.

Instance The instance name of the data source's
SQL Server database. Leave this field
blank if the database is in the default
SQL Server instance.

Ask your local database
administrator.

Port The port number of your SQL Server
database instance.

Ask your local database
administrator. The
default SQL Server port
number is 1433.

Database Name The name of the database within the
SQL Server instance. This can often be
left blank if the account used to access

Ask your local database
administrator.
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Name Description Hints & Finding Values

the database has the correct database
as its default database.

Custom DB URL Select the Custom Editor option to
enter custom database URLs. The
Custom DB URL field is enabled by
selecting the Custom Editor option.

Use of the custom field
requires expertise in JDBC
URL syntax. Only used this
field when instructed by
OpenSpirit support.

Database Query Account Builder

The database query account builder dialog is used to create a database account to be used
to access OpenWorks project information. The dialog is provided as a convenience. Most
companies choose to create the query account using Oracle tools rather than this
OpenSpirit query account builder.

Name Description Hints & Finding Values

DBA
Account

Oracle
account with
permissions to
create Oracle
accounts.

This needs to be a DBA privileged account that used to
create the query account. OpenSpirit does not store this
DBA account and password anywhere. It is only used to
create the query account when the Ok button is pressed.

DBA
Password

Password to
the Oracle
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Name Description Hints & Finding Values

account.

New
Account

The name of
the new
Oracle query
account to be
created.

This account only requires connect privilege to the
project data source of the Oracle database because the
accessed tables have public read access. See the help
for a specific data source type for more details about the
use of the query account.

This account name and encrypted password be stored in
the OpenSpirit metadata repository.

New
Password

The password
to be assigned
to the new
Oracle query
account.

Verify
Password

Repeat the
password to
avoid typing
errors.

Data Source Naming
The data source name is an important part of configuring OpenSpirit data sources. The
name is part of an OpenSpirit data key string and is used by OpenSpirit enabled
applications to find the data in the source projects. Many applications save the OpenSpirit
data key string with the data transferred via OpenSpirit, so any updates can be written
back to the original source project. It is critical that the data source name stays constant.
Avoid changing data source names as you upgrade OpenSpirit and the associated
applications.

With this in mind makes sure you pick a name generic enough to withstand upgrades but
specific enough so your users can easily find their data.
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Project Catalog Scanner
There are certain OpenSpirit supported data sources that do not have a list or catalog of
projects. These data sources have their projects defined by a directory structure. Presently
Kingdom and Petra are supported data sources that fall into this category. In order for
OpenSpirit to “know” about the projects associated with these data sources, it is necessary
to populate a Project Catalog that consists of the project names and disk file locations.
This is accomplished by using the Project Catalog Scanner. The Project Catalog Scanner is
part of the configuration panel of the affected data sources.

To register projects to the catalog, go to the Project Catalog section of the configuration
panel and press the folder icon and browser to the top-level directory of the project
source. Once that is selected press the "Add All Projects Under Path. Select the Path with the
File Chooser" button. The scanner interrogates the directory path and add rows for each
relevant project found. You can also manually add projects individually by pressing the Add
Row icon and entering the project information in the blank row that was added.

Conversely you can delete individual rows by selecting the row and pressing the Delete
Row icon .

Once a project is added and saved, it becomes available for use in the Data Selector.

Treatment of Coordinate Systems
Some of the data sources that OpenSpirit has data connectors to require both specification
of the project's coordinate system as well as the preferred method of doing a datum shift
from the project's geodetic datum to the WGS 84 datum. This information must be
supplied when the project is created using the vendor’s data management tools. This so
called early- binding approach is used by:

l OpenWorks

l Kingdom (Kingdom chooses the datum shift for you starting with version 2015)

l Studio

When OpenSpirit connects to these types of projects the OpenSpirit data connector reads
the project's map projection system type and parameters, the associated geographic
system and parameters, and the preferred datum shift type and parameters and translates
these into standard EPSG nomenclature (see http://www.epsg.org). Then if any application
requests spatial data via OpenSpirit (for example, a well or seismic line location)
OpenSpirit use its Coordinate Service (based on ESRI's Projection Engine) and the

http://epsg.org/
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parameters read from the source project to transform the data to the requested coordinate
system. If the requested coordinate system has a different datum, then the source spatial
data shifted to. WGS84 based on the datum shift method and parameters defined in the
source coordinate system.

Other data sources take the late-binding approach and only define the map and/or
geographic coordinate system for data stored in their project and do not supply any
information on how to do a datum shift to WGS84. This is the approach used by:

l EPOS

l Petra

l PPDM

In order to conveniently use data from these data sources in OpenSpirit workflows we have
added the ability when these data sources are configured (for example, made known to
OpenSpirit) to specify the preferred datum shift for every datum found in that datastore.
So when a PPDM datastore is registered with OpenSpirit a scan is done to find the unique
set of datums used in that datastore instance and the administrator is required to choose
the preferred datum shift method for each datum to shift it to WGS84. If you wish to use a
different datum shift based on where the data is spatially located (for example, use
NADCON in the USA but use NTV2 in Canada to shift from NAD27 to WGS84). Then one can
configure two OpenSpirit datastore instances that point to the same datastore instance but
use different datum shifts between NAD27 to WGS84. In future releases of OpenSpirit we
plan to make the specification of datum shift policies more flexible by allowing spatial
dependent policies to be set and stored in the OpenSpirit metadata repository along with
the EPSG coordinate system definitions.

To start configuring the Data Source, select the desired data source type and version in the
data source tree and click the create data source icon in the tool bar.

Command-Line Configuration Utility
A command-line tool is available for configuring data sources when a graphical display
terminal is not available on the computer that a data source needs to be configured on.

The command-line data source configuration utility is started on Linux using the
dataSourceConfig.sh script found in the bin/etc directory of your OpenSpirit software
installation. The utility is also available on Windows and is started using the
dataSourceConfig.bat file found in the bin\etc folder.
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The command-line utility can be used to create, update, delete, rename, and list data
source configurations. The utility must be run using the OpenSpirit administrator account
used to create the master configuration, or an OpenSpirit account that has been granted
the Administer OpenSpirit Runtime user right.

Create Data Source
Use the following command-line options to create a data source.

-create <input file>

Where <input file> is the name of the file containing the data source configuration
parameter values. Example parameter files for OpenWorks, and SEGY are provided in the
bin/etc directory. Create a copy of one of the example files and edit it to provide the
values needed for your data source.

Update Data Source
Use the following command-line options to modify an existing data source.

-update <input file>

Where <input file> is the name of the file containing the data source configuration
parameter values. Example parameter files for OpenWorks, and SEGY are provided in the
bin/etc directory. Edit one of the example files to provide the values needed for your data
source.

Delete Data Source
Use the following command-line options to delete an existing data source.

-delete <data source type name> <data source type version>
<data source name>

Where <data source type name> is the name of the data source type (for example, SEGY
or OpenWorks)
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<data source type version> is the version of the data source type (for example, 2012 or
R5000)

<data source name> is the name that was given when creating the data source.

Rename Data Source
Use the following command-line options to rename an existing data source.

-rename <data source type name> <data source type version>
<data source name> <new data source name>

Where <data source type name> is the name of the data source type (for example, SEGY
or OpenWorks)

<data source type version> is the version of the data source type (for example, 2012 or
R5000).

<data source name> is the name that was given when creating the data source.

<new data source name> the new name to give the data source.

List Data Source
Use the following command-line options to list out the parameters of an existing data
source.

Note: Some data source configurations contain database account passwords.
The database account password parameters are shown in clear text in the
parameter output.

-list <data source type name> <data source type version>
<data source name> [output file]

Where <data source type name> is the name of the data source type (for example, SEGY
or OpenWorks)

<data source type version> is the version of the data source type (for example, 2012 or
R5000).
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<data source name> is the name that was given when creating the data source.

[output file] optional argument that specifies the name of a file that the parameters
should be written to, omit this option to list the parameters to the console.

Data Source Configuration Details
The details how each data source type is configured are describing in the individual data
source Installation & Configuration guides or from the on-line Help System.

License Monitor
The License Monitor tool is accessed from the OpenSpirit Desktop by clicking the License
Monitor tool bar icon in the Administrator tool bar, or by choosing the Tools >
Administrator > License Monitor menu item. The License Monitor tool is used to view the
features that are available in your OpenSpirit license and to monitor their usage. The
License Monitor can also be used to force check in licenses when running the OpenSpirit
Desktop in admin mode.

Tip: The license path shown at the top of the License Monitor tool is a
configuration setting of your OpenSpirit master installation. The License Monitor
tool displays the license path but cannot be used to modify the license path. The
Install Config Manager tool is used to modify the OpenSpirit master installation's
license path setting.

The License Monitor tool connects to the OpenSpirit Flexlm license daemon when it is first
displayed to retrieve the current license information. This can take from a few seconds to a
few minutes depending on how many license features there are in your OpenSpirit license
file and depending on how many users have licenses checked out. A progress window
appears while the loading is underway. Pressing the Run in Background button dismisses
the progress dialog enabling you to view the license information in the License Monitor as
it is read from the license daemon.



TIBCO OpenSpirit® Runtime User Guide

173 | Administration Tools

You may begin interacting with the License Monitor tool once the license information has
been obtained from the license daemon. Pressing the refresh icon causes the License
Monitor to request the license information from the license daemon again resulting in the
progress dialog to be redisplayed. Select the Always run in background option on the
progress dialog to prevent it from popping up each time a refresh is performed.

The License Monitor tool provides a license feature-oriented view and a user-oriented view
of your OpenSpirit license features. Both views provide the same information, it is just
organized differently.
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License Path Component Selection
The license daemon that is being monitored by the License Monitor tool is displayed above
the Feature View and User View tabs. The License Monitor tool can only communicate
with a single OpenSpirit Flexlm license daemon even though an OpenSpirit installation can
be configured to use licenses from multiple license daemons. The first component in a
multi-daemon configuration is selected by default. Use the License Path selector to select
another license daemon to monitor if you have a multi-daemon license path.

Feature View
The License Monitor tool's Feature View tab is used to view license checkout information
by feature name. The License Monitor tool's Feature View tab shows two tables of
information. The top table lists all of the license features that exist in your OpenSpirit
license file. The list includes the total number of features that exist in the license, how
many are currently checked out, how many are available to be checked out, the date the
feature expires, the date that maintenance expires, and the number of days remaining
before maintenance expires.

Selecting a feature displays information about all checkouts of the selected feature in the
bottom table of the Feature View tab. Each user that has the selected feature checked out
appear as a row in the bottom table. Each row shows the user account, host name, and
feature check-out time. An application name is also displayed if the OspAppConnection
feature was selected.
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User View
The License Monitor tool's User View tab is used to view license checkout information by
user. The User View tab shows two tables of information. The top table lists all of the users
that have one or more OpenSpirit license features checked out. The list includes the
primary account of the user, the user's name, and the user's description.

OpenSpirit license files that are shared between multiple OpenSpirit master installations
may result in features being checked out by an account that has not been registered with
the master installation that the License Monitor tool is connected to. The description of
these unknown users appears as Unknown user in this OpenSpirit installation.

Selecting a user displays information about all the license features checked out by the
selected user. The information includes the license feature name, the host name that the
application or data connector is running on, and the time that the license was checked out.
An application name is also displayed for the OspAppConnection features to indicate the
application that has the universal application connection license feature checked out.
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Refreshing License Information
The License Monitor tool reads the license information from the OpenSpirit Flexlm daemon
when it is first displayed. Click the refresh icon to force the tool to re-read the license
information to see any changes that occur after the tool is open. A refresh is performed
automatically when performing a force check-in or when changing the selected license
path component.

Force License Check-in
The License Monitor tool can be used to check licenses in when the OpenSpirit Desktop is
connected in Admin Mode. This is equivalent to using the Flexlm lmremove utility. License
check-in is performed by selecting a feature or a user and clicking the stop sign icon in
the License Monitor tool bar. The License Monitor tool triggers an automatic refresh when a
force check-in is performed.

Selecting a feature in the Feature View tab checks in all existing check-outs of the selected
feature for all OpenSpirit users. Selecting a user in the Feature View tab checks in the
selected feature checked out by the selected OpenSpirit user.

Selecting a user in the User View tab checks in all existing check-outs of all features for the
selected OpenSpirit user. Selecting a feature in the User View tab checks in the selected
feature for the selected OpenSpirit user.

Licenses that are checked in using the License Monitor tool checked back out if the
application that originally checked it out is still running. There is typically a delay of 10 to
15 minutes before the license is checked back out by the running application.
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Tip: Consider using the Process Manager tool or the User Manager tool's user
deactivation option if your goal is to free up all OpenSpirit licenses that are
being consumed by a specific user.

User Manager
The User Manager Tool is accessed from the OpenSpirit Desktop by clicking the User
Manager tool bar icon or by choosing the Tools > Administrator > User Manager
menu item. The User Manager tool can be used to view and modify information about
registered OpenSpirit users. It can also be used to grant and revoke user rights.

The User Manager window tab displays Admin Mode when connected as the administrator.
Admin mode must be enabled to make changes to the user information. The User Manager
tool can only be used to view user information if not run in admin mode.

The User Manager tool has a two-tab displays, a Users tab, and a Users Rights tab.

Users tab
The Users tab displays a table of all the registered OpenSpirit users. The list may be sorted
by any of the columns by clicking on the header of the column to sort by. The Is Active?
column indicates, with a check mark, if the user is currently connected to the OpenSpirit
services.
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Users are automatically registered with the OpenSpirit framework the first time they run
any OpenSpirit enabled application. Automatically registered users will appear with a
primary account, name, and description that all match the name of the Windows or Linux
account that they were running on when automatically registered. A user's primary account
cannot be changed. Users must be deleted and re-registered to change their primary
account. The secondary account is optional and can be edited. User names and
descriptions may also be edited.

The User Manager's tool bar contains buttons that can be used to create, delete, and
disconnect OpenSpirit users.

Adding New Users

The User Manager tool can be used to register new OpenSpirit users rather than waiting for
automatic registration to occur. Explicit user registration is most often performed when it is
desired to have the user name or description fields contain values other than merely
duplicating the primary account name.
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New users can be added individually by clicking on the create user icon .

The create user icon will open a dialog that is used to enter the new user's primary
account, secondary account, name, and description. The primary account field is the only
required field. The name and description will default to the primary account value if left
blank. The secondary account is optional and is typically left blank. No validation is
performed on the values entered for the primary and secondary accounts, so take care to
enter the account names accurately. The primary account cannot match any existing user's
primary or secondary account. The secondary account cannot match any existing user's
primary or secondary account.

Users can also be added in batch by clicking on the import icon   to select a file

containing information for many users. The import file should contain a line for each user
using a vertical bar character to separate the account fields. The file should be in the form
of:

Primary Account | Secondary Account | Name | Description

The import dialog provides an option to overwrite or to skip any users that match an
existing primary account.
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Deleting Users

The User Manager tool can be used to delete OpenSpirit users. Deleting an OpenSpirit user
will remove all information associated with a user from the OpenSpirit repository. This
includes the user's sessions, server activation preferences, data source credentials, and
private data source configurations. Deleting a user does not remove any Windows or Linux
account associated with the user. Only OpenSpirit information is removed.

Users are deleted by selecting one or more rows in the user table and pressing the delete
icon . An "are you sure" dialog will be displayed giving you a chance to change your
mind and cancel the deletion.

Note: User deletion cannot be undone. All of the user's preference sessions,
private data source configurations, and preference settings will be lost when the
user is deleted.

Editing User Information

The user name, description, and secondary account information can be edited by simply
clicking in the table cell and typing. Edits to user information are not saved until you click
on the save icon in the User Manager tool bar. An edit icon is displayed in the left
most column of each user that has been edited. The edit icons go away when the edits are
saved by clicking on the save icon.

The secondary account is used to associate another Windows or Linux account with an
OpenSpirit user. It is typically only used when an OpenSpirit user has different account
names on Windows and Linux and wishes to run OpenSpirit applications on both accounts.
A secondary account is not required to run data connector processes under different
accounts. A secondary account is only needed to run applications under two different
account names and have them treated as a single OpenSpirit user.

No validation is performed on secondary account information entered using the User
Manager tool. Secondary accounts cannot match any other existing primary account or any
other existing secondary account.

Disconnecting Users

The User Manager tool can be used to disconnect active users from the OpenSpirit runtime.
This feature is provided to enable the OpenSpirit administrator to free resources being held
by OpenSpirit users if it is not possible for the user to release the resources themselves.
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Note: Disconnecting a user will force the user's data connector processes to shut
down and will disconnect any OpenSpirit enabled applications they may be
running. Disconnected users will likely have to restart their OpenSpirit
applications to recover from a disconnect. No warning is given to the
disconnected user, so make sure they are not at risk of losing valuable work
before disconnecting them.

Users that are running one or more OpenSpirit enabled applications or data connectors will
appear with a green check in the IsActive? column of the user table. Select one or

more active users and click on the stop sign icon in the User Manager tool bar to
deactivate the selected active users.

Refreshing User List

Click on the refresh icon to refresh the list of users shown in the User Manager tool.
Refresh will include any new users that have been registered since the list was last
displayed. Refresh can also be used to discard any unsaved edits to user information.

Users Rights tab
Companies may wish to restrict access to some of the capabilities provided by OpenSpirit
tools. For example, some companies may want to restrict the ability to run OpenSpirit scan
jobs to their data management personnel. Other companies may want to prohibit Petrel
users from exporting data out of Petrel using the OpenSpirit Ocean Petrel Application
Adapter. The granting and revoking of these rights is done using the Users Rights tab in
the User Manager tool.
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The rights that can be managed using the Users Rights tab are:

User Right Description Default

Administer
Copy Jobs

The right to create, view, modify, delete, schedule, and run
copy jobs.

The right to create, view, modify* and delete* public copy
rules. The right to view, modify, delete, schedule, and run
copy jobs created by other users.

The right to monitor and cancel copy jobs run by any user.

The right to view and delete copy job run histories for jobs
run by any user.

No

Administer
Data Views

The right to create, view, modify*, and delete* public
model views.

No

Administer
OpenSpirit
Runtime

The right to act as the OpenSpirit administrator without
having to know the OpenSpirit password.

No

Administer
Scan Jobs

The right to create, view, modify, delete, schedule, and
run scan job definitions.

The right to schedule and run scan jobs.

The right to view, modify, delete, schedule, and run scan
job definitions created by other users.

The right to monitor and cancel scan jobs run by any user.

The right to view and delete scan job run histories for jobs
run by any user.

No

Impersonate
OpenSpirit
User

The right to access OpenSpirit data connectors running as
a different OpenSpirit user. This right is typically used to
enable a web service account to act on behalf of other
OpenSpirit users.

No

Petrel Data The right to use the export and save to external features of Yes
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User Right Description Default

Export the TIBCO OpenSpirit Adapter for Petrel.

Run Copy Jobs The right to create, view, modify, and delete copy job
definitions. The right to view public copy rules.

The right to schedule, run, monitor, and cancel copy jobs.
The right to view and delete copy job run histories.

Yes

Run Scan Jobs The right to create, view, modify, and delete scan job
definitions. The right to schedule, run, monitor, and
cancel scan jobs.

The right to view and delete scan job run histories.

Yes

* The default copy rules and model views provided with the OpenSpirit software cannot be
modified or deleted. Copies can be modified.

Assigning Global Rights

Global rights are rights that are granted to every OpenSpirit user. Any OpenSpirit right can
be made global. You must have administrator privilege to grant or revoke global rights.

Global rights are granted or revoked by clicking the Global rights icon in the User
Manager tool bar. This displays the Assign Global Rights window.
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All OpenSpirit rights are listed. Check the rights that you would like all users to have and
un- check the rights that you want to control on a per-user basis.

Note: It is strongly advised to never make the Administer OpenSpirit Runtime
right or theImpersonate OpenSpirit User right a global right.

Adding User Rights

Rights that are not already granted as a global right may be granted to specific users by
selecting one or more user rows and clicking the Add rights icon in the User Manager
tool bar. This displays the Add User Rights window.
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All OpenSpirit rights are listed. Global rights appear grayed out and cannot be controlled at
the user level. Check the non-global rights that you want to grant to the selected users.
Any rights that the selected users already had before displaying the Add User Rights
window are unaffected. Rights cannot be removed from a user by unchecking them in the
Add User Rights window. Rights can only be added using this window. Use the Remove
User Rights window to take rights away from users.

Removing User Rights

Rights that are not already granted as a global right may be removed from specific users by
selecting one or more user rows and clicking the Remove rights icon in the User
Manager tool bar. This displays an Are you sure warning.

Click the No button to cancel the user rights removal operation. Click the Yes button to
proceed to the Remove User Rights window.
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All OpenSpirit rights are listed. Global rights appear grayed out and cannot be controlled at
the user level. Check the non-global rights that you want to remove from the selected
users. Any selected user that has a right that you check that right removed when the Ok
button is pressed.
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Data Management Tool
This section of Data Management Tool covers the following topic:

Jobs
This section of Jobs covers the following topic:

Scheduled Jobs
The Scheduled Jobs tool is used to view and manage scheduled copy and scan jobs. The
Copy Job Manager and Scan Job Manager tools must be used to do the initial job
scheduling. Jobs appear in the Scheduled Jobs window once they have been scheduled
using the copy or scan tool. The Scheduled Jobs window opens automatically when a job
is scheduled using the Copy Job Manager or Scan Job Manager tool. The Scheduled Jobs
window can also be opened by clicking the Scheduled Jobs icon in the OpenSpirit
Desktop tool bar or by choosing the Tools > Data Manager > Scheduled Jobs menu item.

OpenSpirit job scheduling is delegated to the computer's native job scheduler. Jobs
scheduled on computers running a Microsoft Windows operating system are registered with
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the Microsoft Windows Task Scheduler. Jobs scheduled on computers running a Linux
operating system are registered with the Linux cron daemon. The native scheduler (Task
Scheduler or cron) must be available on the computer you are using to schedule. The login
account used to schedule OpenSpirit jobs must have the appropriate permissions to use
the native scheduler. Check with your company's IT organization if you have problems
accessing the native scheduler.

Note: OpenSpirit's use of your computer's native scheduler means that
information about scheduled jobs is only available when running on the
computer used to schedule the job and only when using the login account used
to schedule the job. The list of Scheduled Jobs displayed by the Scheduled Jobs
tool is read directly from your computer's native job scheduler.

Tip: Jobs scheduled using OpenSpirit can be changed or removed using the
Windows Task Scheduler on Windows or cron commands on Linux. Also,
scheduled jobs are not removed when uninstalling or upgrading your OpenSpirit
Runtime. Upgrading your OpenSpirit Runtime may require removing jobs
scheduled with earlier versions of OpenSpirit.

Rescheduling Jobs
Jobs displayed in the Scheduled Jobs window can be rescheduled by selecting the job
entry and clicking the Reschedule icon in the Scheduled Jobs tool bar. This opens the
Schedule Job window.
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The Schedule Job window opens with the Run Now option enabled. Pressing the Ok
button without making any change to the settings cause the job to be started immediately.
The schedule for the job remains unchanged, but the job started when the Ok button is
pressed.

Unchecking the Run Now option enables the date selection icon for selecting a job
start date.

Click the date selection icon to select the date and time that you want the job to begin
running. The Select time and date window open. Select the date and time of day that you
want the job to start.
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Tip: Try clicking the Month/Year title in the calendar. Use of the calendar
selector is described in the Data Selector help document in the Query Filter
Values section.

Next select the interval that you want to schedule the job to run. Select Once to run the
job on the specified start date and then never run it again. Select Daily to run the job every
day, Weekly to run once per week, and Monthly to run once per month. The job starts at
the time of day selected for the start date.

Selecting the End Date option enables the date selection icon for selecting a job end
date. Jobs scheduled with an interval other than once that does not have an end date
continues to start at the prescribed interval indefinitely. Jobs having an end date runs at
the specified interval until the end date is passed.
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Finally select the logging level that you want to use when running the job. The log level
determines the amount of information that is written to the job's log file when the job is
run. The INFO level is selected by default.

The meaning of each log level is described in the following table.

Log
Level

Description

ERROR Produces the least amount of log file output. This level should only be used if
you have no interest in anything but failures.
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Log
Level

Description

WARN Produces less output than INFO. Consider using this level if you are trying to
keep the log file size down and are not interested in details of successful
operations. Only failure information is reported. Messages about data that
could not be copied or scanned are produced, but messages about
successful a successful copy or scan are not produced.

INFO The default level. This is the recommended log level. It produces a
reasonably detailed amount of information about the job execution.
Messages about the number of each data type copied or scanned is
produced using this log level.

DEBUG Produces a large amount of output. You typically should not use this level
unless instructed by OpenSpirit support. Large numbers of program
execution messages needed to diagnose problems are produced when this
log level is used.

ALL Produces a tremendous amount of output. This level should never be used
unless instructed by OpenSpirit support. Volumes of very detailed program
execution messages needed to diagnose difficult problems are produced
when using this log level. This log level may produce multi-gigabyte log files.

The Copy run command to clipboard button places the command used to run the job in the
system clipboard. This can be used to either run the job manually, or to enter the job into
a different job scheduling system. Use the paste feature of another application, such as
Notepad or Microsoft Word, to obtain the command placed in the system clipboard by
clicking this button.

Following is an example of the command used to run a copy job on Microsoft Windows.
The 66dca794-56ce-43e1-ada3-f7a003e2a48d portion of the command is an id that refers
to the copy job definition stored in the OpenSpirit master installation's metadata
repository. This id not valid when used with an OpenSpirit master installation that does not
contain the copy job with this id.

"C:\Program Files\OpenSpirit\v4.3\bin\ospjob.bat" OpenWorks_Teapot_to_
Petra 66dca794-56ce-43e1-ada3-f7a003e2a48d INFO false Copy



TIBCO OpenSpirit® Runtime User Guide

193 | Data Management Tool

Note: The run command may only be valid for starting the job on the same
computer and account used to create the job and schedule it.

Press the Ok button to save the schedule changes.

Saving a job schedule on Windows displays a prompt for your Windows account login
password. The password is used to register the job with the Microsoft Windows Task
Scheduler. No password prompt appears when scheduling on Linux.

Enter your password and press the Ok button to schedule the job using the Microsoft
Windows Task Scheduler. The password is not saved by OpenSpirit. The job should show
the new schedule in the job list.

Removing a Job Schedule
Jobs that have been scheduled can be removed by selecting the job and clicking the
Remove icon in the Scheduled Jobs window tool bar. A confirmation window opens to
confirm your desire to remove the job. Removing a schedule job only removes it from the
scheduler. The copy job definition or scan job definition remains in the OpenSpirit
metadata repository and is available for rescheduling using the Copy Job Manager or Scan
Job Manager tool.
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Job Run History
The Job Run History tool is used to view running Copy Manager and Scan Utility jobs and
to view the output from jobs that have run in the past. There is no reason to use this tool if
you are not using the optional Scan Utility or Copy Manager tool.

The Job Run History tool is accessed from the OpenSpirit Desktop by clicking the Job Run
History icon in the Data Manager tool bar, or by choosing the Tools > DataManager >
Job Run History menu item. This causes the Job Run History window to open.

The Job Run History window shows the history of your Scan Utility and Copy Manager job
runs. The history includes the date and time that the job started, the date and time the job
completed, and the date and time that the job's status message was last updated. Jobs
that are currently running not have a finish date.

Tip: OpenSpirit users that have been granted the Administer Copy Jobs user
right sees run histories for copy jobs run by all users. OpenSpirit users that have
been granted the Administer Scan Jobs user right sees run histories for scan
jobs run by all users. The OpenSpirit administrator user sees copy and scan run
histories for all users. All other OpenSpirit users only see histories for jobs that
they run. They do not see other user's jobs.

Job Execution Display Columns
The User column shows the name of the OpenSpirit user that ran the job. The Account
column shows the login account that was used to run the job.

The Job Type column indicates the type of job, Copy, Scan, or StudioFindScan.

The Dry Run column displays the word true if the job was a dry run. The word false is
displayed if the job was an actual run. Dry run is only supported for copy jobs.

The Job Name column displays the name of the copy job or scan job. The Status column
shows the current status of the job.
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The Status Message column changes periodically when the job is running to provide an
indication of what the job is doing.

The Definition column contains hyperlinks that can be used to open a read only view of
the copy or scan job definition. Click on a link to view a copy or scan job definition.
Opening a job definition may take a few moments if the job definition view needs to
initiate data queries in order to display the job's data selections. See the help guide for
Copy Manager or Scan Utility for details of the job definition views.

The Outputs column contains hyperlinks that can be used to open a view of the job
execution report, messages, and rejection list. Click on a link to view output generated by a
copy or scan job. Job outputs can be viewed during a job run as well as after the job run
has completed. See the help guide for Copy Manager or Scan Utility for details of viewing
the job outputs.

The Begin Date column shows the date and time that the job began running.

The Finish Date column shows the date and time that the job finished. The words Not Set
will appear if the job is still running or if it terminated abnormally.

The Last Updated column shows the date and time that the job's status message was last
updated.

The Host column only appears if the additional columns toggle is enabled. The column
shows the name of the computer that the job was run on.

The PID column only appears if the additional columns toggle is enabled. The column
shows the operating system process id of the job. This can be helpful when using other
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system tools to identify and monitor the job's process when it is still running. The
information is of little use once the job terminates.

Job Run History Tool Bar
The Job Run History window provides a tool bar containing buttons that can be used to
control the job history display and to operate on jobs that are still running and on jobs that
are no longer running. Some tool bar buttons are not enabled until one or more job
histories are selected.

Refresh Button

The refresh tool bar button refreshes the entire job execution table by re-reading the
information from the OpenSpirit master installation's database.

Additional Columns Button

The show additional columns button toggles on and off the display of additional
columns in the table of job executions. The additional columns are displayed on the far
right, which may require the table to be scrolled to the right to see them. The additional
columns are the Host and PID columns.
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Filter Button

The filter button opens the job run history query filter window, which provides several
options to filter job execution rows from being displayed in the table. This can be useful
when you have a very large number of job run histories.

Check one or more filter options by clicking checkboxes along the left edge of the options
window. Jobs matching all selected filter options are shown in the job history table.

The Time Window option provides a few common time intervals to use as filter criteria.
The time Windows or intervals are Yesterday, Last Week, Last Month, and Last Year. The
time window filter is applied based on the begin date of the jobs. Choose one of these
options to filter out all jobs that did not begin running during the selected time window.

The Earliest Begin Date and Latest Begin Date options provide a way to filter jobs based
on a specific interval of time. These options are not available if the Time Window option is
enabled. Specify only a first begin date to filter out jobs older than the specified date.
Specify only a latest begin date to filter out jobs newer than the specified date. Specify
both an earliest and latest begin date to filter all jobs except those started during the
specified time interval.

The Job Type option is used restrict the job histories to only a specific type of jog (for
example, only copy jobs or only scan jobs).

The Status option is used to restrict the job histories to only those histories having a
specified job status.

The User option is used to restrict the job histories to only show jobs run by a specified
OpenSpirit user. This option is only useful if you are a Copy or Scan job administrator or
the OpenSpirit administrator. Regular users can only see their own jobs anyway.
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Press the button at the bottom of the filter window to dismiss the window and
apply the filter to the job run history table.

The word Filtered appears next to the Current Job Executions title above the table of job

histories to indicate when a filter is in effect. A filter icon also appears in the column
heading of the columns that are being used to filter.

Cancel Button

The cancel button is enabled when at least one running job is selected. Pressing the
cancel button sends a cancel request to the running jobs that have been selected. The job
should cleanly end at the next opportunity. The job's status column indicates that a cancel
has been requested. The job should end at the next opportunity.

Abort Button

The abort button is enabled when a job with a Cancel Requested status is selected.
Pressing the abort button initiates an attempt to forcibly kill the running job's process. An
abort can only be performed when the job is running on the same machine as the
OpenSpirit Desktop and is running under the same account.

Note: The abort button should only be used as a last resort. It can cause the
running job to exit in a way that could potentially cause corruption of the job's
message log or possibly corrupt the database that it is writing its output to.

Delete Button

The delete button is enabled when one or more completed jobs are selected. Pressing
the delete button deletes the history record and job output of all selected jobs. The history
cannot be recovered after deletion, so make sure that the history is no longer needed
before performing a delete.
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Tip: Job run histories are maintained in the OpenSpirit master installation's
database. Histories can be quite large and can accumulate over time consuming
significant storage space in the OpenSpirit master installation. Large numbers of
histories can also slow down performance of the Job Run History tool. Consider
deleting old histories that are no longer needed for audit trail purposes.

Send to Support Button

The send to support button is enabled when a single job is selected. Pressing the send
to support button causes a zip file to be created that contains files that helpful when
entering a support issue about problems running the job. A window appears that shows
where the zip file was created. The zip file is not automatically sent to TIBCO OpenSpirit
Support. The user is responsible for attaching the zip file to a support request entered
using the TIBCO online support portal.

Help Button

Pressing the help button opens this help document.

Model View Manager
A Model View represents a custom view of the OpenSpirit data model or of a native data
model. Model Views are similar in concept to SQL views. They are used to present a
database in a more user-friendly form. A model view can present a subset of the data
model's data types and attributes. A model view can also change the names of data types
and attributes and can join related data types to create a data type. Model views enable
companies to present data in the OpenSpirit tools using terminology common to the
company. Model views also enable companies to subset the data types to only expose the
data types and attributes that are populated with data in their data stores.

The OpenSpirit framework includes a single model view for the OpenSpirit data model. It is
used for browsing data in the Data Selector. Installing the optional OpenSpirit Scan Job
Manager adds another model view that is based on the OpenSpirit data model. The scan
model view is used to control how spatial data is handled by the Scan Job Manager tool.
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The Model View Manager tool can be used to inspect these model views, derive new model
views from them, or create entirely new model views for viewing the OpenSpirit data
model or view native data models.

Overview
The Model View Manager Tool is accessed from the OpenSpirit Desktop by clicking the
Model View Manager tool bar icon or by choosing the Tools > Data Manager > Model
View Manager menu item. The Model View Manager tool is used to inspect, create, and
modify model views used by the OpenSpirit Data Selector and the OpenSpirit Scan Job
Manager.

The table in the upper left corner of the Model View Manager window lists all of the model
views that exist in your OpenSpirit installation. The model views are stored in the
OpenSpirit metadata repository that resides in the OpenSpirit master installation.

The Default column indicates if a model view is the default model view for its type. Only
one model view of a given type can be a default. Marking a model view as the default for
its type causes the tools that use the model view to have it selected by default. For
example, making a Data Selector model view the default causes the Data Selector tool to
show it as the selected model view in its Data Source Selection window. Making a Scan Job
model view the default causes the Scan Job Manager to show it as the default scan model
view.

The Model View Name column shows the name of the model views.

The Version column shows the model view's version. Newly created model views are
assigned version 1.0. The version number is incremented each time the model view is
edited. Only the highest version of a model view is available in the Model View Manager.

The Type column indicates if the model view was created for use in the Data Selector, the
Scan Job Manager, or in Studio Scan.

The Data Model column indicates the data model that the view is for.

The Visibility column indicates if the model view is available for use by all OpenSpirit users
or only by the user running the Model View Manager. Private model views can only be seen
and used by the user that creates them.

The Description column displays an optional textual description that is typically used to
describe the purpose of the model view.
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The upper right section of the Model View Manager window is primarily used when creating
model views. It can also be used to edit the description and properties of a model view.
The bottom half of the Model View Manager window is used to browse and edit the details
of the model view.

Model View Manager Tool Bar
The Model View Manager tool bar contains buttons used to view, create, edit, delete,
import, and export model views. These actions are described in the following sections of
this help guide. The tool bar resides in the upper right-hand corner of the Model View
Manager window.
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Refresh Button

The refresh button closes any model view that is open for edit and re-reads the list of
model views from the OpenSpirit metadata repository.

Save Button

The save button is enabled when a model view is open for editing and at least one
change has been made to the model view. Press the save button to write the model view
changes to the OpenSpirit metadata repository.

Save As Button

The save as button is used to create a copy of a model view. Select a model view in the
model view list and press the save as button. You are prompted to enter the name to give
the new model view. The new copy appears in the model view list.

Create Button

The create button is used to create a model view. See the Creating New Model Views
section of this guide for information about creating model views.
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Import Button

The import button is used to import a model view file that was created using the
model view export feature. Click the import button to open a file selection window. Select
the model view file to be imported. The imported model view appears in the model view
list.

Export Button

The export button is used to export a model view to a file. Export is typically used to
copy a model view to a different OpenSpirit master installation. The model view file can be
loaded into an OpenSpirit installation using the import feature.

Select the model view to be exported and click the export button. You are prompted to
select the directory that the model view exported to. The model view written to a file
where the file name is the same as the model view name and the file name extension be
.ospmodelview. For example, exporting a model view named MyModelView creates a file
named MyModelView.ospmodelview.

Edit Button

The edit button is enabled when a model view is selected in the model view list. Click
the edit button to open the selected model view for editing. Model views can also be
opened for editing by double-clicking a model view in the model view list. See the Editing
Model Views section of this guide for information about model view editing.

Delete Button

The delete button is enabled when a model view is selected in the model view list.
Click the delete button to delete the selected model view. Model view deletion cannot be
undone.

Help Button

The help button opens this help guide.
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Viewing Model Views
Model views can be viewed by double-clicking a model view in the model view table, or by
selecting a model view and clicking the Edit icon in the Model View Manager tool bar.
The model view is open for both viewing and editing if the user has edit rights to the
model view. The model view is opened in a read-only mode if the user does not have
permission to edit it. The default Data Selector model view and scan job model view that is
included in your OpenSpirit installation cannot be edited. Make a copy in order to edit
them. This restriction insures that updates to your OpenSpirit installation that include
changes to the default model views not impact any changes made by customers.

A warning message is displayed when opening a model view that the user does not have
write access to.

Pressing the Ok button opens the model view in read-only mode. Changes to the model
view cannot be made when opened in read-only mode.
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The upper right section of the model view window displays the model view header
information. This includes the name of the data model that the model view is based on. It
also shows the name of the model view, the type (Data Selector or Scan Job), the visibility
scope (Public or Private), the version of the model view, and any description that was given
to the model view.

The lower left section of the model view window displays the data types and data type
groups that make up the data model that the model view is based on. The lower right
section of the model view window shows the model view data types and groups. Clicking
the description icon next to a model view data type opens a window that displays the

description given to the model view data type by the person constructing the model view.

The window also displays the description of the data type from the data model.



TIBCO OpenSpirit® Runtime User Guide

206 | Data Management Tool

The model view data type description appears as the tool tip when hovering the mouse
pointer over the data type tab in the Data Selector tool.

Clicking the configure icon next to a model view data type in the lower right section of
the model view window displays the model view data type details window for the model
view data type. The Select Attributes tab on the details window lists all of the attributes
available for the data model data type that the model view data type was derived from.
The following example shows the Well model view data type from the OpenSpirit Default
model view, which was derived from the Well Bore data type from the OpenSpirit v2.9 data
model.
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The Available column indicates if an attribute available for display in tools using this
model view.

The Displayed column indicates if the attribute is turned on for display by default. The
attribute must be available in order to be displayed by default.

The Display Name column shows the name that appears in the Data Selector column
header for the attribute.

The Data Type Attribute column shows the display name of the attribute in the data
model, in this case the OpenSpirit v2.9 data model.

The Data Type column shows the display name of the data model data type that the
attribute belongs to. This column is useful when joining multiple data model data types
into a single model view data type.

The Attribute Type column indicates the type of the attribute (for example, TIMESTAMP,
FLOAT_QUANTITY, VARCHAR).

Clicking an attribute's Description icon opens a window that displays the description

that was given to the attribute. The attribute description appears as a tool tip when
hovering the mouse over the attribute's column header in the Data Selector.
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Clicking an attribute's Properties icon opens a window that displays properties that
have been assigned to the model view attribute. Properties are used to indicate special
handling for some attributes in tools that use the model view, such as the Scan Job
Manager.

Clicking an attribute's Format icon opens a window that shows any custom display
format settings that have been applied to the attribute. The model view attribute's display
format settings override any default display settings in the desktop preference settings.

The Relationships section at the bottom of the window lists all related data types that are
available to join into the model view data type.

The Apply Query Filter tab of the model view data type details window shows any query
filter that has been configured for the model view data type.

Query filters can be added to a model view data type to constrain it to display a subset of
the data that is available in the data source. See the help documentation for the Data
Selector Query Filter Window for instruction in using the query filter builder.

Tip: For example, a model view could contain a data type named "Deep Wells"
that was derived from the OpenSpirit Well Bore data type with a query filter on
the Total Depth attribute to exclude all well bores except bores with Total Depth
> 6,000 meters.
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The bottom section of the Apply Query Filter tab shows the default View Scope and
default Spatial Attribute to use for the model view data type.

The Settings and Properties tab of the model view data type details window shows if the
data type's tab is turned on for display in the Data Selector by default, and it shows if
sending data selection events for the rows in the Data Selector tab is allowed.

The User-Defined Properties section at the bottom of the Settings and Properties tab
shows any properties that have been assigned to the data type. Properties are sometimes
used to signal special handling for some tools, such as the Scan Job Manager tool.

Model View Creation and Editing
This section of Model View Creation and Editing covers the following topic:

Creating New Model Views
New model views are created by clicking the Create model view icon in the Model
View Manager tool bar. This clears out the Model View Name field and Description field in
the upper right section of the Model View Manager window and sets the Selected Data
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Model, Model View Type, and Visibility selections to their default values. The bottom-left
section of the window shows the data type groups that exist in the selected data model
and the lower right section of the window empty. The Model View Manager window is now
ready for you to begin defining the new model view.

Data Model Selection

First select the data model that the model view used to view. Model views created from the
OpenSpirit data model can be used to view any data source type that is supported by
OpenSpirit. Model views created against any other data model can only be used to view
data sources of that data model type. For example, selecting the OpenWorks R5000 data
model means the model view that you are creating can only be used to view OpenWorks
R5000 data sources. It cannot be used to view Kingdom, PPDM, or any other data source
type. The data model that you select determine the data types and groups that are
available in the lower left section of the Model View Manager window. These are the data
types that available for constructing the model view data types.

Model View Name

Next give your model view a meaningful name. Public model view names must be unique
among all existing public model views. Private model view names must be unique among
all private model views owned by the user that is creating it.
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Model View Type

Select the model view type. The model view types that can be created are listed in the
following table.

ModelView
type

Product
using the
type

Description

Data
Selector

OpenSpirit
Data
Selector

Model views that are used to control how OpenSpirit model
or native model data types are displayed in the Data
Selector.

ArcGIS OpenSpirit
Extension for
ArcGIS

Model views that are used to control how GIS features are
created in ArcGIS Pro when data selection events are
received by the extension.

Excel
Adapter

OpenSpirit
Adapter for
Excel

Model views that are used to control how GIS features are
created in ArcGIS Pro when data selection events are
received by the extension.

Scan Job OpenSpirit
Scan Utility

Model views that are used to control the data types and
attributes that are written by the Scan Utility outputs.

Scan for
Studio

OpenSpirit
Scan for
Studio

Model views that are used to control the data types and
attributes that are written to the Studio index.

Spotfire Spotfire
Adapter for
OpenSpirit

Model views that are used to control the data types and
attributes that are imported as Spotfire data tables.

Model View Visibility

Select the visibility that you would like the model view to have. Public model views are
available for use by all OpenSpirit users. Private model views are only available to the user
that creates them. You must have the Administer Data Views right in order to create,
modify, or delete a public model view. The OpenSpirit administrator can grant or deny any
OpenSpirit user the Administer Data Views right. Any OpenSpirit user that has been granted
the Administer Data Views right can edit or delete any public model view, regardless of
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the user that created it. The only exception is the model views that are created during
installation of OpenSpirit. The model views included OpenSpirit cannot be edited.

Model View Properties

Properties can be assigned to a model view. Properties consist of name/value pairs. Model
view properties are provided for the convenience of application developers as a way to
assign values to a model view that can be used to control application-specific behaviors.

There is typically no need to assign any properties to a model view unless you are
instructed to do so by an application supplier.

Note: Any properties that appear on model views included in the OpenSpirit
Runtime or model views that are installed by other OpenSpirit applications such
as the OpenSpirit Scan Utility or the OpenSpirit Copy Manager should not be
deleted or modified unless explicitly instructed to do so by OpenSpirit support.

Model View Description

The model view description is optional. It can be used to explain the intended purpose for
the model view if the model view name does not make its use apparent.

Tip: The model view name, data model, and model view type cannot be
changed once the model view has been saved. You can rename a model view by
making a copy by clicking the Save as icon and giving the copy the new
name. The model view must be recreated in order to change the data model or
the model view type. The visibility and description can be changed after the
initial save.

Once all of the information has been entered in the upper right section of the Model View
Manager window, you can begin building up the content of your model view. This is
described in the Building Model View Groups and Data Types section of this help guide.
Click the Save icon periodically during the construction of your model view to save the
current state. Clicking the save icon writes the model view to the OpenSpirit metadata
repository. The model view's version number will be incremented each time the model
view is saved after the initial save. There is no way to access older versions of a model
view. Only the most recent version is available for viewing and editing.
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Editing Model Views
Model views can be modified by selecting them in the list of model views and clicking the
Edit icon in the Model View Manager tool bar. This opens the model view in edit mode
if the user owns the model view or has the Administer Data Views right. The only model
view header information that can be edited is the visibility, description, and the model
view properties. The data model, model view name, and model view type cannot be
changed after the model view has been created and saved.

Most model view editing is done using the Data Model and Model View sections at the
bottom of the Model View Manager window. This is described in the help guide chapter
titled Building Model View Groups and Data Types.

Building Model View Groups and Data Types
The lower left section of the Model View Manager window contains the data model groups
and data types. The lower right section of the Model View Manager window contains the
model view groups and data types.



TIBCO OpenSpirit® Runtime User Guide

214 | Data Management Tool

The model view data type groups and data types are built up by dragging data model data
types and/or groups from the lower left section of the window and dropping them in the
lower right section. Dragging and dropping a group bring over all of the data types that
exist in the data model group. Groups and data types that have been added to the model
view can be renamed or removed by clicking them and pressing the right mouse button. A
popup menu appears that contains options to create a group, rename the selected group
or data type, or delete the selected group or data type. Deleting a group or data type does
not remove it from the data model in the lower left section of the window. They can always
be dragged over to the model view again.

Dragging the same data type to the model view a second time causes the Name exists
window to appear.

This window gives you the opportunity to share the data type within the model view,
create a data type within the model view, or cancel the drag. Data types are shared in
order to have them appear in more than one model view group. Shared data types appear
in multiple groups, but they are actually a single data type. Renaming shared data types or
editing their configuration applies to all occurrences of the shared data type within the
model view.
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A new name must be given to the data type when selecting the Create New option. The
new model view data type is used to view the same data model data type, but appear in
the model view with a different name and can have different attributes enabled, different
query filters, and other settings from the other model view data types created from the
same data model data type.

Tip: Sharing was done with the Project data type in the OpenSpirit Default
model view. The Project data type appears in all of the model view groups so it
can be easily accessed without having to select a different group tab in the Data
Selector. The Create New option was used in the OpenSpirit Default model view
to create details tabs in the Data Selector. For example, the Well group in the
OpenSpirit Default model view contains a Well data type and a Well Details
data type. Both of these model view data types were derived from the
OpenSpirit data model's Well Bore data type joined with attributes from the
Well data type. The Well data type and a Well Details data type both represent
a Well Bore. They differ in the attributes that are available for display and in the
View Scope choices.

The Visible checkbox next to each model view data type determines if the tab
representing the data type is turned on in the Data Selector by default.

The top to bottom order that the model view data types appear within the group
determines the left to right order that the data type tabs appear in the Data Selector.
Model view data types can be dragged up or down to change the order.

Click the Configure icon next to each model view data type to open the model view
data type details window that is used to configure the attributes to be included in the data
type and how they are displayed. The details window is described in the next section of
this help guide.

New groups can be created by typing a new group name in the field at the bottom center
of the Model View Manager window and pressing the Add New Group button
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. The new group appears at the bottom of the Model View - Groups and Data Types table.
Data types can then be added to the group and the group can be moved up or down in the
group order by dragging it with the mouse.

Configuring Model View Data Types
Click the Configure icon next to a model view data type to open the model view data
type details window that is used to configure the attributes to be included in the data type
and how they are displayed. The data type details window contains three tabs, a Select
Attributes tab, an Apply Query Filter tab, and a Settings and Properties tab. These tabs
are described in the following help guide sections.

Model View Data Type Details Window

Select Attributes tab

Most of the model view data type configuring is done in the Select Attributes tab. The
majority of the tab displays the attributes that are available from the data model selected
when creating the model view. The bottom section of the tab lists data types that have a
relationship defined in the data model that permits them to be joined with the primary
data model data type used to create the model view data type being configured.



TIBCO OpenSpirit® Runtime User Guide

217 | Data Management Tool

Select the checkbox in the Available column next to attributes that you want to make
available for use in tools using this model view. Deselecting the Available option on an
attribute automatically deselect the Displayed option for that attribute.

Select the checkbox in the Displayed column next to attributes that you want to be visible
by default in tools using this model view. Selecting the Displayed option automatically
select the Available option. Attributes must be available to be displayed.

Clicking the Select all rows icon in tab's tool bar selects the Available option for all
attributes. Clicking the Clear all rows icon in the tab's tool bar deselects the Available
option and the Displayed option for all attributes.

The Display Name for an attribute can be changed by clicking in the Display Name table
cell and typing in a new name. The Display Name appears as the column header in tools,
such as the Data Selector that uses the model view.

The Attribute Type column indicates how the attribute is represented (for example, as a
TIMESTAMP, INTEGER, VARCHAR). Some attribute types support custom display format
options. For example, TIMESTAMP attributes can be displayed as just a date, or as a date
and a time of day. FLOAT_QUANTITY attributes can be displayed with the number and unit
in the same column or in separate columns. Attributes that support custom display format
options appear with an edit icon in the Format column. Clicking the edit icon opens a
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window that can be used to set display format options that apply to just that attribute.
Attribute-specific format settings override any display format preferences set in your
OpenSpirit Desktop preference settings.

The order that attributes marked for display appears in tools using the model view can be
set by clicking the Set Column Order icon in the tab's tool bar. This opens the Set
column ordering window, which shows all of the attributes selected for display. Attributes
can be reordered by selecting one or more attributes to be moved and clicking the up
or down arrow icons. This moves the selected attributes up or down one row for each
icon click. The order that the attributes appear top to bottom in the list corresponds to the
attribute column ordering left to right in the tools using the model view.

Clicking the Ok button accepts the reordering and dismisses the window. The rows
selected for display in the Select Attributes tab reordered to match the new ordering.

Attributes from related data types can be added to the attribute list by clicking the Add
Attributes button next to one of the related data types listed at the bottom
of the Select Attributes tab. This opens an attribute selection window used to select the
attributes from the related data type that you would like to add to the attribute list.
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Select the attributes that you want from the related data type and press the Ok button.
The selected related attributes will be added to the attribute list after the last attribute
that has the Available option selected. The added attributes are selected as Available but
the Displayed option not checked. Check the Displayed option if you would like the
related attribute to be displayed by default.

The related data type's attribute selection window has a section at the bottom that shows
data types that it is related to. You can click the Add Attributes button next
to one of its related data types to continue following relationships adding additional
attributes.

Tip:
Adding attributes from related data types results in join queries. The more
related data types that you join in the longer the query execution time in tools
using the model view, such as the Data Selector.



TIBCO OpenSpirit® Runtime User Guide

220 | Data Management Tool

Apply Query Filter tab

The Apply Query Filter tab is used to add constraints on the data rows that are shown in
tools using the model view. This tab functions almost exactly like the Query Filter window
in the OpenSpirit Data Selector. See the Setting Query Filters section of the Data Selector
help guide for an explanation of how to construct a query filter.

The only significant difference between the Model View Manager's Apply Query Filter tab
and the Data Selector's Query Filter window is the Scope to same type option at the bottom
right of the tab.

This option is typically used to construct a data type that is intended to serve as a details
tab. Checking this option constrains the data type so its view scope can only be set to
another data type derived from the same data model data type. This feature was used to
create the Well Details and Log Details data types in the OpenSpirit default Data Selector
model view.

Settings and Properties tab

There is rarely a need to use the Settings and Properties tab. The Data type is visible by
default option is redundant to the option in the Visible column on the model view section
of the Model View Manager main window. The Data selection events enabled option is used
to prevent tools using the model view, such as the OpenSpirit Data Selector, from
permitting data selection events to be sent for selected rows of the data type. This is
typically used to avoid user confusion when it is known that no applications exist that is
interested in listening for data selection events for that data type.
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The User-Defined Properties section of this tab is used to add properties that can be used
to control special handling in tools using the model view, such as the Scan Job Manager.

Note: Any user-defined data type or attribute properties that appear in model
views included with the OpenSpirit Runtime or model views that are installed by
other OpenSpirit applications such as the OpenSpirit Scan Utility or the
OpenSpirit Copy Manager should not be deleted or modified unless explicitly
instructed to do so by OpenSpirit support.
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Glossary

A

admin mode: The OpenSpirit Desktop tools run with elevated privileges when the desktop
is in admin mode. TheOpenSpirit Desktop is placed in admin mode by running it from the
OpenSpirit administrator account, or by using theadmin mode toggle button in the
Administrator tool bar.

attribute: A property of a data type. Attributes are referred to as 'columns' in relational
database terminology.

C

computing platform: A computer operating system such as Microsoft Windows 7, Red Hat
Enterprise 5, Solaris 10, etc.

D

data connector: Software component used to connect the OpenSpirit framework to a
source of data. A data source could be represented by a relational database, by a collection
of file based data, by a web service, or some combination of these data storage and data
access technologies.

data key: An object that identifies a specific data item in a specific data store. Data keys
can be represented as XML.

data selection events: A broadcast event that sends the identity of one or more data
items to all applications being run by an OpenSpirit user that are listening for data
selection events.

Data Selector: OpenSpirit Desktop tool used to browse data residing in OpenSpirit enabled
data stores.

data type: A type of data, such as well, seismic survey, well log, lease, etc.. Data types are
also commonly referred to as 'entities', 'tables', or 'business objects'.

data type view: A term used to refer to the tabs in the OpenSpirit Data Selector that
display rows of data of a given data type (e.g. wells, seismic volumes. etc.).
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drag and drop: The action of selecting one or more items and using the computer mouse
to drag them onto another window or application.

E

EPSG: The now-defunct European Petroleum Survey Group (EPSG). The EPSG was
absorbed into the Surveying & Positioning Committee of the International Association of Oil
& Gas Producers (OGP) in 2005.

G

geoscience data repositories: A repository of geoscience data, often referred to by
OpenSpirit as a data source. A data repository or data source can be represented by a
relational database, by a collection of file based data, by a web service, or some
combination of these data storage and data access technologies. Examples are
Halliburton's OpenWorks database, IHS' Kingdom and Petra databases.

H

home directory: Computer file system home directory. The location of your home
directories vary by computer operating system and by company.

M

Model View: A custom view of a native data model or the OpenSpirit data model. A Model
View can present a subset of the data model's data types and attributes. A Model View can
also change the names of data types and attributes and can join related data types to
create a new data type.

N

native data model: The logical data model defined by OpenSpirit enabled data sources.
For example, the "OpenWorks 2003" logical data model is a native data model. The "PPDM
3.7" database schema is a native data model.

O

OpenSpirit data model: A data model created by OpenSpirit Corporation. The OpenSpirit
data model is a canonical data model that is representative of the data models commonly
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used in the E&P disciplines addressed by OpenSpirit.

operating system process id: The Microsoft Windows, Linux, and Solaris computer
operating systems all assign a unique integer id number to all processes that are running
on the computer. The id numbers are unique among the processes currently running on
the computer. The operating system process id is commonly referred to using the acronym
PID which stands for process id.

P

process starter: A background process created by the OpenSpirit framework that is used
to create data connector processes. A process starter process could be considered to be a
service process or a daemon process.
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TIBCO Documentation and Support Services
For information about this product, you can read the documentation, contact TIBCO
Support, and join TIBCO Community.

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the Product Documentation website,
mainly in HTML and PDF formats.

The Product Documentation website is updated frequently and is more current than any
other documentation included with the product.

Product-Specific Documentation

The documentation for this product is available on the TIBCO OpenSpirit® Runtime Product
Documentation page.

To directly access documentation for this product, double-click the following file:

TIBCO_HOME/release_notes/TIB_os-rt_4.3.1_docinfo.html

where TIBCO_HOME is the top-level directory in which TIBCO products are installed. On
Windows, the default TIBCO_HOME is C:\tibco. On UNIX systems, the default TIBCO_HOME
is /opt/tibco.

How to Contact Support for TIBCO Products

You can contact the Support team in the following ways:

l To access the Support Knowledge Base and getting personalized content about
products you are interested in, visit our product Support website.

l To create a Support case, you must have a valid maintenance or support contract
with a Cloud Software Group entity. You also need a username and password to log
in to the product Support website. If you do not have a username, you can request
one by clicking Register on the website.

https://docs.tibco.com/
https://docs.tibco.com/
https://docs.tibco.com/products/tibco-openspirit-runtime
https://docs.tibco.com/products/tibco-openspirit-runtime
https://support.tibco.com/s/
https://support.tibco.com/s/
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How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee
subject matter experts to share and access their collective experience. TIBCO Community
offers access to Q&A forums, product wikis, and best practices. It also offers access to
extensions, adapters, solution accelerators, and tools that extend and enable customers to
gain full value from TIBCO products. In addition, users can submit and vote on feature
requests from within the TIBCO Ideas Portal. For a free registration, go to
TIBCO Community.

https://ideas.tibco.com/
https://community.tibco.com/
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Legal and Third-Party Notices
SOME CLOUD SOFTWARE GROUP, INC. (“CLOUD SG”) SOFTWARE AND CLOUD SERVICES EMBED,
BUNDLE, OR OTHERWISE INCLUDE OTHER SOFTWARE, INCLUDING OTHER CLOUD SG SOFTWARE
(COLLECTIVELY, “INCLUDED SOFTWARE”). USE OF INCLUDED SOFTWARE IS SOLELY TO ENABLE THE
FUNCTIONALITY (OR PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED CLOUD SG
SOFTWARE AND/OR CLOUD SERVICES. THE INCLUDED SOFTWARE IS NOT LICENSED TO BE USED OR
ACCESSED BY ANY OTHER CLOUD SG SOFTWARE AND/OR CLOUD SERVICES OR FOR ANY OTHER
PURPOSE.

USE OF CLOUD SG SOFTWARE AND CLOUD SERVICES IS SUBJECT TO THE TERMS AND CONDITIONS
OF AN AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED AGREEMENT, OR, IF THERE IS NO
SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER AGREEMENT WHICH IS DISPLAYED WHEN
ACCESSING, DOWNLOADING, OR INSTALLING THE SOFTWARE OR CLOUD SERVICES (AND WHICH IS
DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH LICENSE AGREEMENT OR CLICKWRAP
END USER AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE SOFTWARE. USE
OF THIS DOCUMENT IS SUBJECT TO THOSE SAME TERMS AND CONDITIONS, AND YOUR USE HEREOF
SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this
document may be reproduced in any form without the written authorization of Cloud Software
Group, Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, and OpenSpirit are either registered trademarks or
trademarks of Cloud Software Group, Inc. in the United States and/or other countries.

All other product and company names and marks mentioned in this document are the property of
their respective owners and are mentioned for identification purposes only. You acknowledge that all
rights to these third party marks are the exclusive property of their respective owners. Please refer to
Cloud SG’s Third Party Trademark Notices (https://www.cloud.com/legal) for more information.

This document includes fonts that are licensed under the SIL Open Font License, Version 1.1, which is
available at: https://scripts.sil.org/OFL

Copyright (c) Paul D. Hunt, with Reserved Font Name Source Sans Pro and Source Code Pro.

Cloud SG software may be available on multiple operating systems. However, not all operating
system platforms for a specific software version are released at the same time. See the “readme” file
for the availability of a specific version of Cloud SG software on a specific operating system platform.

https://www.cloud.com/legal
https://scripts.sil.org/OFL
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THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES
ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE INCORPORATED
IN NEW EDITIONS OF THIS DOCUMENT. CLOUD SG MAY MAKE IMPROVEMENTS AND/OR CHANGES IN
THE PRODUCT(S), THE PROGRAM(S), AND/OR THE SERVICES DESCRIBED IN THIS DOCUMENT AT ANY
TIME WITHOUT NOTICE.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT
NOT LIMITED TO ANY RELEASE NOTES AND "README" FILES.

This and other products of Cloud SG may be covered by registered patents. For details, please refer
to the Virtual Patent Marking document located at https://www.tibco.com/patents.

Copyright © 2000-2024. Cloud Software Group, Inc. All Rights Reserved.

https://www.tibco.com/patents
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